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RESUMO 
 

 Este estudo apresenta os resultados obtidos na aplicação do método 

de padronização k0-INAA no LAN–IPEN, para a análise de amostras biológicas, 

utilizando o programa k0-IAEA, fornecido pela Agência Internacional de Energia 

Atômica (IAEA). Os parâmetros de fluxo f e α do reator IEA-R1 do IPEN foram 

determinados na estação pneumática de irradiação e na posição de irradiação 

24B/prateleira2, para irradiações curtas e longas, respectivamente. Para obter 

esses fatores, foi utilizado o chamado método bare triple-monitor com 197Au-96Zr-
94Zr. Para a verificação da precisão e exatidão do método, foram analisados os 

materiais biológicos de referência Peach Leaves (NIST SRM 1547), Mixed Polish 

Herbs (INCT-MPH-2) e Tomato Leaves (NIST SRM 1573a). Os critérios 

estatísticos Erro Relativo (bias, %), Coeficiente de Variação (CV) e U-score foram 

aplicados para avaliação dos resultados obtidos (média de seis replicatas). Os 

erros relativos (bias, %) ficaram, para maioria dos elementos, entre 0 e 30%, em 

relação aos valores certificados. Os Coeficientes de Variação foram inferiores a 

20%, mostrando boa reprodutibilidade nos resultados obtidos experimentalmente. 

Os valores de U-score mostraram que todos os resultados, com exceção do valor 

para Na no Peach Leaves e no Tomato Leaves, estão dentro de um intervalo de 

confiança de 95%. Estes resultados apontam para uma promissora utilização do 

método k0-INAA no LAN-IPEN para a análise de amostras biológicas. 
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Daniel Corrêa Puerta 
 
 

ABSTRACT 
 

 
The results obtained in the application of the k0-standardization method at 

LAN-IPEN for biological matrices analysis, by using the k0-IAEA software, provided 

by the International Atomic Energy Agency (IAEA), are presented. The flux 

parameters f and α  of the IEA-R1 reactor were determined for the pneumatic 

irradiation facility and for one selected irradiation position, 24B/shelf2, for short 

and long irradiations, respectively. In order to obtain these parameters, the bare 

triple-monitor method with 197Au-96Zr-94Zr was used. In order to evaluate the 

accuracy and precision of the methodology, the biological reference materials 

Peach Leaves (NIST SRM 1547), Mixed Polish Herbs (INCT-MPH-2) e Tomato 

Leaves (NIST SRM 1573a) were analyzed. The statistical criteria Relative Errors 

(bias, %), Coefficient of Variation (CV) and U-score were applied to the obtained 

results (mean of six replicates). The relative errors (bias, %) in relation to certified 

values, were, for most elements, in the range of 0 e 30.  The Coefficients of 

Variation were below 20%, showing a good reproducibility of the results. The U-

score test showed that all results, except Na in Peach Leaves and in Tomato 

Leaves, were within 95% confidence interval. These results point out to a 

promising use of the k0-INAA method at LAN-IPEN for biological sample analysis. 
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1. INTRODUÇÃO 

 

 Com base nos fundamentos da Física Nuclear e da Química 

Inorgânica, a Análise por Ativação Neutrônica (NAA) (GUINN, 1980) foi 

descoberta em 1936, quando George de Hevesy e Hilde Levi verificaram que 

amostras contendo certo tipo de terras raras tornavam-se altamente radioativas 

após exposição a uma fonte de nêutrons. Anteriormente, em 1934, ocorreu a 

descoberta da radioatividade artificial, quando o casal Irene Curie e Frederic Joliot 

mostraram que as partículas, identificadas por Rutherford como parte dos núcleos 

atômicos, emitidas por elementos naturalmente radioativos, poderiam ser 

utilizadas para bombardear elementos não-radioativos e induzir esses elementos 

a serem radioativos. 

 Inicialmente, o desenvolvimento e a aplicação da Análise por Ativação 

Neutrônica foram dificultados pela limitação do baixo fluxo das fontes de nêutrons, 

desempenho limitado dos cíclotrons e falta de detectores de raios gama eficazes 

para espectrometria de raios gama. Nos anos 40 e 50, no entanto, esse método 

teve um crescimento muito rápido, devido à construção e distribuição de reatores 

nucleares de pesquisa com elevado fluxo de nêutrons térmicos em diversas 

localidades do mundo, o advento dos primeiros detectores de alta eficiência e as 

primeiras conferências internacionais dedicadas exclusivamente ou de forma 

significativa a estudos de NAA. Na década de 70, houve grande incentivo ao 

desenvolvimento da análise por ativação com nêutrons, com a invenção dos 

detectores de alta resolução de germânio (GUINN, 1980). Atualmente, é uma 

técnica analítica bem estabelecida, e é especialmente conveniente em diversos 

tipos de estudos, por ser uma técnica multielementar, não destrutiva, e requerer 

pequena quantidade de amostra na análise, da ordem de miligramas. Além disso, 

o aprimoramento da eletrônica nuclear e a utilização de computadores tornaram 

esta técnica de alta sensibilidade aplicável em muitos campos da ciência, sendo 

continuamente aprimorada e largamente utilizada para determinação de 

elementos traço em materiais diversos.  
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 A determinação da concentra0ção de elementos químicos em amostras 

é assunto de interesse em muitas áreas de pesquisa e conhecimento. Pela sua 

sensibilidade, seletividade e também pelo fato de cerca de 70% dos elementos 

químicos apresentarem nuclídeos que possuem propriedades adequadas para a 

aplicação do método da análise por ativação com nêutrons, este método 

radioquímico mostrou-se um dos mais importantes para este tipo de análise 

(GLASCOCK, 2000). 

 Há muitos anos, o laboratório de Análise por Ativação com Nêutrons do 

IPEN (LAN-IPEN) vem analisando diferentes matrizes, geológicas, vegetais e 

animais, empregando o método de análise por ativação com nêutrons 

comparativo (FÁVARO et al., 2000; FIGUEIREDO et al., 2009 e 2011; SEMMLER, 

2007) no reator de pesquisa IEA-R1. Esta técnica consiste na irradiação 

simultânea da amostra a ser analisada e de um padrão, com concentração bem 

conhecida do elemento a ser analisado. A irradiação do padrão e da amostra é 

efetuada sob as mesmas condições, durante o mesmo tempo e sob o mesmo 

fluxo de nêutrons; posteriormente, amostras e padrões são medidos na mesma 

geometria experimental. Nesse processo, todos os parâmetros associados à 

irradiação e detecção são iguais, tanto para a amostra como para o padrão, 

tornando possível a determinação da concentração de um elemento na amostra 

por meio de uma comparação entre as atividades induzidas na amostra e no 

padrão.   

 A estratégia funciona bem quando se quer determinar apenas um ou 

alguns elementos. No entanto, quando se quer determinar um grande número de 

elementos de uma amostra, o preparo dos padrões sintéticos, que inclui 

dissolução de reagentes químicos, preparo de soluções e tomada de alíquotas 

para contagem, é muito complicado e demorado, além da dificuldade que surge 

devido à irradiação de um grande número de padrões e amostras num só 

recipiente de irradiação. O uso de materiais de referência como padrões acarreta 

alguns problemas como alto custo e disponibilidade limitada. 

 Para solucionar essas dificuldades, foi desenvolvido, no final dos anos 

setenta e início dos anos oitenta, pelos professores Frans De Corte (Universidade 

de Gent, Belgica) e Dr. Andras Simonits (KFKI-AEKI, Budapeste, Hungria) e 

muitos outros colegas de trabalho, o método de ativação neutrônica k0 (k0-INAA) 
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(DE CORTE et al., 2000; SIMONITS et al., 1975; KOLOTOV e DE CORTE, 2004). 

O método de padronização k0 depende da determinação exata das eficiências de 

pico para as energias gama de interesse, em um espectrômetro gama; da relação 

entre fluxo de nêutrons térmicos e epitérmicos (valor de f) e do parâmetro 

relacionado à distribuição de energia dos nêutrons epitérmicos (valor de �). 

Requer também maior reprodutibilidade nas instalações de irradiação e detecção, 

além de constantes nucleares obtidas da literatura (DE CORTE, 1987b e 2001; 

SMODIS et al., 1990).  

 O procedimento usado para aplicação do método de padronização k0 

consiste em irradiar cada amostra juntamente com um monitor de fluxo, também 

chamado como comparador, no mesmo canal de irradiação. Várias amostras 

podem ser irradiadas simultaneamente quando empilhadas dentro do recipiente 

de irradiação (coelho), intercaladas com monitores de fluxo (na forma de 

sanduíche). A concentração dos elementos é calculada em relação ao monitor, 

que é usualmente o ouro, eliminando a necessidade de padrões. 

 A partir de 1992, mais de 50 laboratórios de todo o mundo passaram a 

utilizar o método k0-INAA em seus laboratórios, e centenas de trabalhos sobre o 

tema têm sido publicados (IAEA). No Brasil, o método k0-INAA tem sido aplicado 

com sucesso no CDTN / CNEN (Centro de Desenvolvimento de Tecnologia 

Nuclear / Comissão Nacional de Energia Nuclear, Belo Horizonte, Minas Gerais) 

(MENEZES e JACIMOVIC, 2008; MENEZES et al., 2003).e no CENA (Centro de 

Energia Nuclear e Agricultura, Piracicaba, São Paulo (BACCHI e FERNANDES, 

2003a; BACCHI et al, 2003b; BACCHI et al, 2004).  Nas duas últimas décadas 

houve um significante desenvolvimento na determinação das constantes físicas 

envolvidas, assim como na melhoria de programas de computação utilizados nos 

cálculos necessários, possibilitando a obtenção de resultados confiáveis, 

comparáveis aos obtidos pelo método comparativo.  

 Em 1995, a análise por ativação com nêutrons instrumental k0-INAA, foi 

introduzida no CDTN. Testes confirmaram que o reator TRIGA MARK IIPR-RI 

apresentava as características adequadas para aplicação do método, 

principalmente devido à sua estabilidade e fluxo de nêutrons homogêneo.  Em 

2003, o método foi otimizado com a introdução do software KayWin, o qual se 
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mostrou mais apropriado para análise dos espectros e das concentrações 

elementares (MENEZES et al., 2003; MENEZES e JAĆIMOVIĆ, 2008). 

 O método k0-INAA, utilizando o programa k0-IAEA, para análise de 

materiais geológicos foi empregado no LAN-IPEN. Para obter os parâmetros de f 

e α, foi utilizado o método bare triple-monitor com 197Au-96Zr-94Zr. Os resultados 

obtidos para até 30 elementos nos materiais de referência basalto JB-1 (GSJ) e 

BE-N (IWG-GIT), andesito AGV-1 (USGS), granito GS-N (ANRT), SOIL-7 (IAEA) e 

sedimento Buffalo River Sediment (NIST–BRS-8704) concordaram com os 

valores recomendados, com erros relativos (bias) menores que 10%. Os critérios 

estatísticos z-score, zeta-score e U-score foram aplicados para avaliação dos 

resultados (MARIANO, 2012). 

 No Egito, na cidade do Cairo, foi implementado, recentemente, o 

método k0-INAA no reator de pesquisa ETRR-2, em operação desde 1998 

(SOLIMAN et al., 2011). Este método de padronização tem sido responsável por 

toda a demanda de Análise por Ativação com Nêutrons, atendendo às 

necessidades dos clientes externos e internos. Os parâmetros foram 

determinados em cada posição de irradiação utilizando Zr e Au como monitores 

de fluxo de nêutrons. Para validação do método, foram analisados os materiais de 

referência carvão NIST 1632c e solo IAEA-Soil-7. O método ‘‘bare triple monitor’’ 

(SIMONITS et al., 1975; DE CORTE et al., 1981; DE CORTE e SIMONITS, 2003) 

foi aplicado nesse trabalho para a determinação dos parâmetros do espectro de 

nêutrons (f e α) que são necessários para os cálculos das concentrações. Os 

critérios estatísticos utilizados foram o desvio em relação ao valor certificado 

(bias, %) e  zeta-score. Uma boa concordância entre os valores experimentais e 

os valores certificados foi obtida. Os resultados obtidos por Soliman et al., (2011), 

revelaram que o método do k0-INAA estabelecido no reator de pesquisa ETRR-2 

pode ser considerado como um método de padronização confiável de INAA e 

como método analítico disponível para análise química de amostras, 

especialmente para aquelas para as quais é difícil encontrar um material de 

referência adequado. O autor do trabalho sugere que os valores podem ser 

melhorados se o método do k0-INAA for aplicado conforme a convenção de 

Westcott. 
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 Com base no Método k0-INAA determinaram-se elementos maiores e 

traços em alguns minerais presentes na mina de Allchar, República da Macedônia 

(JAĆIMOVIĆ et al., 2002). A concentração de U e Th em todos os minerais 

investigados foi considerada menor que 1 mg kg-1. Os dados obtidos para outros 

elementos traço (Ce, Co, Cr, Cs, Sc, Se, Te e Tb) mostraram que as 

concentrações dos minerais investigados foram também baixas (0,6 - 2 mg kg-1 

para Ce; 0,1 - 17 mg kg-1 para Co; 0,4 - 6,7 mg kg-1 para Cr; 0,04 - 52 mg kg-1 

para Cs; 0,006 – 3,5 mg kg-1 para Sc; 0,4 – 0,9 mg kg-1 para Se e 2,6 mg kg-1 para 

Te). As concentrações de Fe, Ca, Mg, As e Sb encontradas nestes minerais foram 

relativamente elevadas (0,02 - 40% de Fe; 0,3 - 21% de Ca; 0,03 - 13% de Mg; 

0,4 - 53% de As e 8 - 270 mg kg -1 de Sb). Para determinar os parâmetros α e f foi 

utilizado o Método da Razão de Cádmio com Monitores Múltiplos. Para obtenção 

das concentrações dos elementos químicos, utilizou-se de um software chamado 

KAYZERO/SOLCOI®, operado em um computador compatível da IBM. Os 

resultados obtidos mostraram-se concordantes com os valores 

estequiometricamente obtidos para todos os minerais. 

 Hoje em dia, o método k0-lNAA tem sido responsável por 90% da 

demanda analítica dos Laboratórios de Análise por Ativação Neutrônica. Vários 

elementos são determinados (Ag, Al, Au, As, Ba, Br, Ca, Cd, Ce, Cl, Co, Cr, Cs, 

Cu, Dy, Eu, Fe, Ga, Hf, Hg, Ho, I, K, La, Mg, Mn, Mo, Na, Nd, Rb, Sb, Sc, Se, Sm, 

Sr, Ta, Tb, Th, Ti, U, V, W, Yb, Zn e Zr) em diversos tipos de matrizes, tais como 

biomateriais (alimentos, plantas, leveduras, tecidos humanos e animais, 

medicamentos, etc); amostras ambientais (solos, sedimentos, água, efluentes 

líquidos, partículas no ar, etc); produtos industriais (ligas, plásticos, etc.). Em 

2006, os Laboratórios de Análise por Ativação Neutrônica produziram 20.000 

resultados aplicando-se o método k0 (MENEZES, 2009). 

 Existem alguns programas computacionais disponíveis dedicados ao 

método de padronização k0, tais como k0-IAEA (ROSSBACH et al., 2007) e o 

KayWin (Kayzero para Windows, 2008) (MENEZES et al., 2003; MENEZES e 

JAĆIMOVIĆ, 2008), que é comercializado. A Agência Internacional de Energia 

Atômica (IAEA) distribuiu gratuitamente aos laboratórios de Análise por Ativação 

com Nêutrons o programa k0-IAEA, que vem sendo continuamente aprimorado, e 

que já vem sendo utilizado em laboratórios como o do Interfaculty Reactor 
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Institute of Technology (IRT), da Delft University of Technology, Holanda, e o 

Instituto Nuclear Tecnológico (ITN), em Portugal (DUNG et al., 2008).  

 

1.1 Objetivo do Trabalho 

 O objetivo do projeto foi propor o método k0-INAA como uma nova 

alternativa para o método comparativo de análise por ativação com nêutrons, 

usualmente utilizado no LAN-IPEN.  

 Devido às vantagens apresentadas pelo método k0-INAA, utilizando-se 

do programa k0-IAEA, espera-se otimizar o processo de obtenção dos resultados 

no LAN-IPEN. Deste modo, pretende-se: eliminar os erros relacionados aos 

cálculos do método comparativo; eliminar o uso de padrões diversos; aumentar a 

quantidade de amostras analisadas e determinar o maior número de elementos 

presentes em cada material irradiado.  
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2. FUNDAMENTOS TEÓRICOS 

 

2.1 Interação da radiação gama com a matéria  

 

 Os raios gama podem interagir com a matéria através de vários 

processos diferentes. Dentre estes processos de interação, os mais importantes, 

do ponto de vista de detecção da radiação gama, são o efeito fotoelétrico, o efeito 

Compton e a produção de pares. Os outros efeitos como o espalhamento 

Thomson, espalhamento Raleigh e outros, podem ser considerados como sendo 

desprezíveis para o processo de detecção dos raios gama (RESNICK e 

EISBERG, 1979). 

 

2.1.1 Efeito Fotoelétrico 

 

Efeito fotoelétrico é o processo pelo qual um fóton de energia �� interage 

com um elétron ligado, transferindo a ele toda a sua energia. Como resultado 

dessa interação, o elétron é ejetado do átomo com uma energia cinética (��) dada 

por: 

�� � �� � 	
                             (1) 
 
onde: 

�� é a energia do fóton incidente; 

	
 é a energia de ligação do elétron na i-ésima camada. 

 

A lacuna criada na camada pela saída do elétron, como um resultado 

do efeito fotoelétrico, é preenchida por elétrons de órbitas mais externas. Este 

processo é geralmente acompanhado pela emissão de raios X ou elétrons Auger 

(quando o átomo excitado transfere diretamente a sua energia para um dos seus 

elétrons). 
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O efeito fotoelétrico não pode ocorrer para um elétron livre. Este fato 

decorre da incompatibilidade das leis de conservação de energia e momento ao 

considerarmos a interação de um fóton com um elétron livre. Portanto, para a 

ocorrência do foto-efeito, é muito importante que o elétron esteja ligado a um 

átomo na qual parte da energia do fóton deve ser transferida. Ainda, pode-se 

concluir que, quanto menor for a energia de ligação do elétron quando comparada 

com a energia do fóton, menos provável é a ocorrência do fenômeno.  

A probabilidade de ocorrência do efeito fotoelétrico depende muito 

fortemente do número atômico Z do átomo no qual o efeito é observado, e pode 

ser representada por (2): 

 

��
��         �           ��                    (2) 
 
 

Em elementos leves (pequeno Z), os elétrons estão ligados mais 

fracamente pelas forças coulombianas do núcleo do que nos elementos pesados 

e, portanto, a probabilidade de ocorrência do efeito deve ser menor. 

De uma maneira geral, a secção de choque para o efeito fotoelétrico 

(σphot)  tem a seguinte dependência com a energia hv da radiação gama e a carga 

Z do meio (MUKKIN, 1987):  

 

         ��
��       �     ��
�
��� �⁄           para  �� � 	�             (3) 

onde: 

	� é a energia de ligação do elétron na camada k. 

  

 O efeito fotoelétrico é, portanto, especialmente significante em baixas 

energias e para materiais pesados onde a probabilidade é relativamente grande 

mesmo para fótons de altas energias. Em materiais leves, por outro lado, este 

efeito é importante apenas para fótons de baixas energias. Desta forma podemos 

concluir que o efeito fotoelétrico é o principal mecanismo de interação da radiação 

gama com a matéria em baixas energias (até algumas centenas de keV). 
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2.1.2  O espalhamento Compton 

 

 Esse fenômeno investigado por Arthur Compton em 1923, (COMPTON, 

1923a e 1923b) ocorre envolvendo uma colisão entre fótons e elétrons, podendo 

provocar a ionização de um átomo. À medida que a energia aumenta, os fótons 

comportam-se como partículas que colidem com os elétrons dos átomos. Dessa 

forma, não só o elétron atingido é liberado, como o fóton repulsado também 

emerge da colisão, sendo importante na faixa de energia típica dos raios-X 

(energias maiores que algumas dezenas de keV) (RESNICK e EISBERG, 1979). 

Além da geração de um elétron livre, no espalhamento Compton ainda resta parte 

da energia do fóton incidente sob a forma de um fóton remanescente, embora de 

menor energia (FIG. 2.1). 

 

 
Figura 2.1 - Diagrama esquemático do espalhamento Compton (RESNICK e EISBERG, 1979). 

 

 A probabilidade de interação de um fóton de alta energia através de 

espalhamento Compton é proporcional à densidade de elétrons em um dado 

material; da mesma forma que no efeito fotoelétrico, o efeito Compton é 

proporcional à densidade do meio. No entanto, à medida que a energia do fóton 

incidente aumenta, diminui a probabilidade dessa interação (aproximadamente 

1/E). 

 A característica principal do espalhamento Compton está na relação 

entre a fração da energia do fóton incidente subtraída no processo, e os ângulos 

de espalhamento do fóton e do elétron produzidos. Em uma grande transferência 
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de energia, o ângulo de espalhamento do fóton Compton poderá ser de até 180º, 

sendo que, nesses casos, o elétron produzido será ejetado em uma direção 

próxima à direção original do fóton incidente.  

 No caso inverso, quanto maior a fração da energia transferida para o 

fóton Compton, mais próxima será sua direção à do fóton de alta energia 

incidente. De fato, como o fóton Compton espalhado tende a apresentar uma 

energia próxima do fóton incidente, pode-se considerar que, nesses casos, 

ocorreu um espalhamento com uma pequena mudança de direção e de energia. 

Nesses caos, o ângulo de espalhamento do elétron Compton gerado tende a ser 

máximo – nunca porém maior que 90º relativo à direção do fóton incidente.  

 Quanto menor a energia do fóton incidente, menor a chance de que 

uma interação proporcione uma grande transferência de energia. Fótons de 

energia mais baixa resultam em uma emissão de fótons Compton num padrão 

praticamente isotrópico. No entanto, à medida que a energia do fóton incidente 

aumenta, o padrão de emissão começa a favorecer a emissão de fótons Compton 

na direção do feixe incidente.  

 

2.1.3  Produção de pares (RESNICK e EISBERG, 1979) 

 

 Nesse processo, ocorre a interação dos fótons de um feixe de alta 

energia com a matéria, que não envolve diretamente a ionização de átomos do 

meio. Desde que haja a presença de um núcleo atômico em sua trajetória, um 

fóton que possua energia acima de 1,022 MeV pode dar origem a um par 

elétron/anti-elétron. 

 A existência do anti-elétron (elétron de carga positiva denominado 

pósitron) é prevista pela fórmula E= mc2, que nada mais significa que matéria e 

anti-matéria ao se encontrarem se aniquilam (massa se transforma em energia), o 

processo inverso (onde energia se transforma em massa, como na produção de 

par) é igualmente possível. 

 A massa de repouso de um elétron e do pósitron é 0,511 MeV/c2. 

Através do fenômeno produção de pares, um fóton com energia pouco acima de 
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1,022 MeV poderá interagir com o campo elétrico do núcleo de um átomo, 

resultando em um par elétron/pósitron (FIG. 2.2). 

 

 
Figura 2.2 – Produção de pares (RESNICK e EISBERG, 1979) 

 

 Dessa forma, o processo de criação de pares é possível apenas para 

fótons de energia acima de 1,022 MeV. Como a interação se dá entre o campo 

eletromagnético associado ao fóton de alta energia e o campo eletrostático do 

núcleo do átomo, a probabilidade de interação através de produção de pares 

cresce com o número atômico, aproximadamente linearmente com Z.  

 Caso o fóton que sofreu interação tenha mais do que 1,022 MeV, o 

excedente de energia será convertido, em geral de maneira não equânime, em 

energia cinética para cada uma das partículas do par elétron/pósitron recém-

criado. 

 Entre ambas as partículas produzidas, haverá um ângulo inversamente 

proporcional à energia do fóton incidente. No caso particular onde a energia do 

fóton seja muito próxima de 1,022 MeV, o elétron e o pósitron resultantes serão 

produzidos em direções praticamente opostas.   

 

2.2  Interação do nêutron com a matéria (BYRNE, 1995) 

 

 Embora, o nêutron não apresente carga elétrica liquida e, portanto, seja 

insensível à força Coulombiana, pode interagir com a matéria via colisões ou 

interações nucleares.  

 A principal forma de interação dos nêutrons com a matéria é através de 

espalhamento, principalmente o espalhamento elástico. Nesse tipo de 
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espalhamento, a energia cinética total do sistema se mantém após a colisão; após 

diversas colisões, a tendência do nêutron é de perder progressivamente 

praticamente toda a sua energia, entrando em equilíbrio térmico com o meio. 

Esses nêutrons são chamados de nêutrons térmicos, e sua distribuição de 

energia ocorre conforme a distribuição de Maxwell-Boltzmann: 

 

��� � �
 !"                                                      (4) 

onde: 

k é a constante de Boltzmann; 

T é a temperatura do meio 

 

 Outra forma de interação do nêutron com a matéria é por meio de 

reações nucleares, uma vez que não sentem a interação eletromagnética. Na 

maior parte das vezes, nessa interação, os núcleos produzidos nessas reações 

são instáveis, ou seja, vão sofrer algum decaimento radioativo antes de atingir um 

estado de equilíbrio; essa característica serve como base para uma série de 

processos, como por exemplo os que ocorrem na NAA. 

 

2.2.1 Secção de choque (σ) (BYRNE, 1995) 

 

 A grandeza física que quantifica a probabilidade de ocorrência das 

reações nucleares é denominada secção de choque (σ). Considerando n(x) a 

intensidade de um feixe de nêutrons após cruzar uma espessura x de um dado 

material e N o número de átomos por centímetro cúbico do alvo, supondo que o 

alvo seja composto por átomos de um único isótopo, então:  

 

#$
#% � �&'#%                                                              �(� 

onde σ tem dimensões de área e é uma medida da probabilidade de interação 

dos nêutrons incidentes com o meio. 
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 A secção de choque varia de acordo com o meio, uma vez que o 

nêutron interage diretamente com as forças nucleares internas ao núcleo. Nesse 

caso, a secção de choque não varia apenas conforme o elemento químico de que 

o meio é composto, mas também de isótopo para isótopo; isto é uma 

característica fundamental da interação dos nêutrons com a matéria. Além disso, 

a secção de choque também depende da energia do nêutron e a interação 

predominante varia de acordo com a faixa de energia do nêutron.  

 Para a maior parte dos isótopos, os nêutrons de baixa energia ao 

interagirem com o núcleo permanecem em algum estado de ligação disponível, e 

a energia restante dessa interação é devolvida sob a forma de uma emissão 

gama. Essa é a chamada captura neutrônica ou absorção neutrônica, 

representada pela forma: 

)* �$, ,� )*-.                                             (6) 

onde: 

)  - é o símbolo químico do elemento; 

A  -  é o número de massa do isótopo em questão. 

 

 Neste tipo de reação, em geral, a secção de choque até uma dada 

energia segue a Lei do 1/v, ou seja, a secção de choque é inversamente 

proporcional à velocidade do nêutron incidente. A Lei do 1/v vale até energias que 

variam de núcleo para núcleo, mas em geral estão em torno de 1 eV – 10 keV; a 

partir dessa energia, frequentemente, notam-se ressonâncias bastante 

pronunciadas na secção de choque, que ocorrem quando o nêutron incidente tem 

energia correspondente a algum nível disponível no núcleo alvo.  

 Os nêutrons também podem induzir reações nucleares com a ejeção 

de uma ou mais partículas, por exemplo, reações (n,p), (n,d), (n,2n) ou (n,α). Para 

essas reações, em geral, há um limiar de energia abaixo do qual o nêutron é 

incapaz de iniciar a reação – essas reações são conhecidas como reações 

limiares. Além dessas reações apresentadas, os nêutrons podem também 

disparar uma reação violenta e radical a alguns núcleos. Núcleos pesados, como 

no caso do 235U ou 239Pu podem, ao interagir com um nêutron, sofrer o processo 
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conhecido como fissão nuclear, onde o nêutron incidente sobre o núcleo o rompe 

totalmente  de forma extremamente exotérmica, sendo o produto, na maioria das 

vezes, dois núcleos menores e dois ou três nêutrons avulsos.  

 

2.3  O método de análise por ativação neutrônica  

 

 O princípio da análise por ativação consiste em expor o material a ser 

analisado a um bombardeio de partículas carregadas, fótons ou nêutrons, de 

modo que ocorra a formação de núcleos radioativos por meio de reações 

nucleares. Desta forma, a partir da medida da radiação emitida por esses núcleos 

radioativos, é possível realizar análises qualitativa e quantitativa dos elementos 

químicos presentes na amostra. 

 No emprego de nêutrons no processo de ativação, a grande vantagem 

vem do fato de o nêutron ser praticamente insensível à interação coulombiana, 

uma vez que não tem carga elétrica líquida, e ter um momento magnético muito 

pequeno. Os nêutrons mesmo com baixa energia podem provocar diversas 

reações nucleares tais como: (n,γ); (n,p); (n,α); (n,n); (n,2n), etc. Como essas 

reações dependem tanto da energia do nêutron incidente (térmico, epitérmico ou 

rápido) como das características do elemento alvo (principalmente da secção de 

choque e da abundância isotópica), vários radioisótopos podem ser formados. 

Quanto mais elevados forem esses valores, maior será a atividade do 

radioisótopo produzido. Os nêutrons térmicos e epitérmicos, em geral, interagem 

com a matéria por espalhamento elástico (n,n)  ou por captura radioativa (n,γ); os 

nêutrons rápidos interagem, principalmente, por espalhamento inelástico (n,n’) ou 

por emissão de partículas carregadas pelo núcleo composto, via reações do tipo 

(n,p), (n,α), etc (KNOLL, 1979). 

 Quando um nêutron interage com um núcleo alvo por meio de uma 

colisão inelástica, forma-se um núcleo composto em um estado altamente 

excitado. Este núcleo pode perder sua energia por vários processos de 

desintegração, que duram da ordem de 10-16 a 10-14 s. Esses processos 

normalmente envolvem emissão de partículas ou os chamados raios gama 

pronto. Na maioria dos casos, o núcleo produto instável começa a decair 
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Figura 2.3 – Típica reação nuclear do tipo (n,γ). 
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r análises qualitativas e quantitativas do 
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 A técnica NAA pode pertencer a duas categorias: 

� Análise por ativação com nêutrons de raios gama pronto (prompt gamma 

rays), na qual a medição se dá durante a irradiação. Esta técnica é 

conhecida por PGNAA. 

� Análise por ativação com nêutrons de raios gama de decaimento (delayed 

gamma rays). Esta técnica é conhecida por DGNAA (método usualmente 

empregado em reatores nucleares). 

 Na prática, o procedimento mais utilizado é com raios gama de 

decaimento, pois, num processo comparativo entre as duas técnicas, o fluxo de 

nêutrons que a amostra recebe sendo submetida à irradiação dentro do reator é 

muito maior do que o produzido pela extração de um feixe no reator.  A PGAA é 

menos sensível que a NAA e tem aplicação na determinação de elementos de 

elevada secção de choque para captura de nêutrons, como o B, Cd, Sm, Gd; 

elementos que decaem muito rapidamente para serem medidos por NAA; 

elementos que produzem apenas radionuclídeos estáveis ou para elementos com 

intensidades de decaimento de raios gama fracas (ZAMBONI, 2007; TRAVESI, 

1975). 

 Parâmetros como as energias e o tipo das radiações emitidas por 

esses nuclídeos e a meia-vida do nuclídeo formado, interferem na sensibilidade 

da análise. A determinação qualitativa e quantitativa dos nuclídeos formados é 

feita por espectrometria de raios gama, com detectores semicondutores de alta 

resolução (Ge hiperpuro), pois cada nuclídeo radioativo tem características 

peculiares para estas emissões (meia-vida e energia), o que permite que se 

realizem análises multielementares. 

 Os pulsos gerados da interação da radiação incidente com o cristal do 

detector de Ge hiperpuro são amplificados e coletados na memória de 

analisadores de altura de pulsos, na forma de um espectro de energias. O 

espectro é interpretado por programas de computação, que localizam os picos de 

raios gama, determinam sua energia e calculam as suas áreas. 

 A relação entre a radiação emitida e aquela realmente detectada 

dependerá de algumas características dos instrumentos disponíveis para a 

realização das medidas. Essas características se referem à eficiência de medida, 



17 

 

arranjo geométrico para contagem, efeitos de espalhamento e absorção da 

radiação. 

 

2.3.1 Método comparativo em análise por ativação neutrônica 
 

Neste processo de ativação, a amostra e o padrão são irradiados sob a 

mesma intensidade do feixe de nêutrons; além disso, o padrão precisa ser feito do 

mesmo material da amostra, uma vez que o freamento que a partícula sofre no 

alvo e no padrão está diretamente relacionado à composição química de ambos. 

No emprego do método via padrão interno o procedimento consiste em 

irradiar uma mistura homogênea de amostra e padrão que contenha um elemento 

com meia-vida próxima à meia-vida do elemento a ser analisado na amostra. 

Utilizando padrão externo, prática utilizada no LAN-IPEN, a amostra e o padrão 

são irradiados simultaneamente, garantindo assim as mesmas condições de 

irradiação. A massa é então determinada a partir da relação das atividades da 

amostra e do padrão. A equação geral que fornece a atividade induzida por um 

fluxo de nêutrons é expressa por (TRAVESI, 1975): 

 

/ � 012�345
6 71 � 9:;<
=                                                      �7� 

onde: 

01 - constante de Avogadro; 

 -  fluxo de nêutrons; 

� -  secção de choque; 

3  - massa do elemento na amostra; 

4 -   fração do isótopo que irá sofrer a ativação; 

5 -   fração do elemento ativado; 

�
 -   tempo de irradiação; 

6 -  massa atômica do elemento; 

? -   constante de decaimento. 
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 Desta forma, a razão entre as atividades da amostra e do padrão, para 

o mesmo tempo de decaimento, reduz-se a: 

 

/@
/� �

3@
3�

                                                                         �8� 
 

onde : 

/@ - atividade do radioisótopo na amostra; 

/�- atividade do radioisótopo no padrão; 

3@ - massa do elemento na amostra; 

3�- massa do elemento no padrão; 

 

Após a irradiação, amostra e padrão são submetidos à contagem 

utilizando o mesmo arranjo experimental. Assim, a atividade passa a ser expressa 

pela taxa de contagem.  

 

2.4 Validação de métodos analíticos  

 

 O desenvolvimento de um método analítico, a adaptação ou 

implementação de um método conhecido, envolvem processos de avaliação que 

estimem sua eficiência na rotina do laboratório. A esses processos costuma-se 

dar o nome de validação. Várias definições estão descritas na literatura para 

validação, tratando-se, portanto de termo não-específico. Determinado método é 

considerado validado se suas características estiverem de acordo com os pré-

requisitos estabelecidos. Portanto, existe diferença entre a execução de 

experimentos que determinam os diversos parâmetros (coleta dos dados 

experimentais) e a validação. Essa deve avaliar a relação entre os resultados 

experimentais e as questões que o método se propõe a responder (BRITO et al., 

2005). O objetivo da validação consiste em demonstrar que o método analítico é 

adequado para o seu propósito (WALSH, 1999). A validação deve ser 

considerada quando se desenvolve ou efetua adaptações em metodologias já 

validadas, inclusão de novas técnicas ou uso de diferentes equipamentos. 



19 

 

 A literatura dispõe de vários trabalhos que relatam a validação de 

métodos analíticos (CAUSON, 1997; CURRIE e SVEHLA, 1994; HUMBERT et al., 

1999; FEINBERG e RAGUÈNÈS, 1999; MCDOWALL, 1999; WIELING et al., 

1996) e definem os critérios que devem ser seguidos durante seu 

desenvolvimento. Dentre esses trabalhos muitos são da área biológica (CAUSON, 

1997; HUMBERT et al., 199; WIELING et al., 1996). 

 Os materiais de referência Peach Leaves (SRM 1547), Mixed Polish 

Herbs (INCT-MPH-2) e Tomato Leaves (SRM 1573a) são destinados, 

principalmente, para uso na avaliação da confiabilidade de métodos analíticos 

para a determinação de elementos maiores, menores e traço em 

materiais botânicos, produtos agro-alimentares e matérias de matriz similar.  

 Os valores dos materiais de referência são baseados sobre o acordo 

de pelo menos dois métodos analíticos independentes ou a média de um método 

de precisão conhecido. No caso de dois ou mais métodos, cada incerteza é a 

soma de um limite de confiança de 95% (±2s) e uma margem de erro sistemático 

entre os métodos utilizados. No caso de um método de precisão conhecido, cada 

incerteza é a soma de um limite de confiança de 95% (NIST, 1993). 

 Em algumas publicações (DE CORTE et al,; 1987b; FREITAS e 

MARTINHO, 1989a; FREITAS, 1989b), a comparação entre os métodos de 

análise por ativação com nêutrons k0-INAA e o método comparativo foi realizada 

utilizando materiais de referência certificados e precisões similares foram 

encontradas para ambas as técnicas (SMODIS et al., 1992).  
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3.  MÉTODO k0-INAA 
 

Desenvolvido no Nuclear Sciences Institute, em Gent, Bélgica e 

proposto por Simonits em 1975 (SIMONITS et al., 1975), o método de análise por 

ativação k0, surgiu como alternativa aos métodos de análise por ativação absoluto 

e comparativo. Esse método consiste em parametrizar os conjuntos de dados 

nucleares experimentais ou teóricos que aparecem na expressão do método 

absoluto, em uma única grandeza, que por sua vez pode ser determinada com 

relativa facilidade. Este método combina a simplicidade experimental do método 

absoluto, com a precisão do método relativo, de maneira que, com a utilização de 

um único monitor, a concentração do elemento possa ser determinada. 

Este método exclui as incertezas relacionadas ao uso de um padrão, 

mas por outro lado, inclui as incertezas de k0, que são menores que as primeiras, 

não excedendo 3,5%. Outra vantagem do método é que as amostras e o 

comparador de Au podem ter diferentes formas e diferentes características de 

absorção de nêutrons e raios gama. 

A determinação experimental do conjunto de dados nucleares 

necessários aos cálculos da atividade é feita pela irradiação de monitores de 

fluxo. A concentração dos elementos é calculada em relação a um elemento, 

geralmente ouro, eliminando a necessidade de padrões.  

As constantes k0 foram medidas em alguns institutos de pesquisa 

especializados, entre eles o Instituto de Ciência Nuclear em Gent, o Instituto KFKI 

em Budapest e o Instituto Riso na Dinamarca, sendo que atualmente já existem 

valores para 140 reações �B, C� (DE CORTE et al., 2003).  

O fator k0 de um isótopo a ser analisado pode ser definido, com 

referência ao comparador de ouro, como (SIMONITS et al., 1975): 

 

( )
AuAua

aaAu

Au

Au

a

IM

IM
ak

,0

,0
,0

σθ

σθ

γ

γ
=                                          (9) 
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onde: 

o índice “a” é para o analito (elemento da amostra a ser analisado); 

o índice “Au” é para o ouro (e refere-se à reação 197Au(n,γ)198Au, Eγ = 411,8 keV e         

k0,Au = 1); 

M – massa atômica do elemento irradiado; 

θ – a abundância isotópica; 

Iγ – probabilidade de emissão gama por decaimento para a transição considerada; 

σ0  – a secção de choque para nêutrons térmicos (2200 m s-1).  

 Os fatores k0 para a maioria dos elementos que podem ser analisados 

por meio da análise por ativação com nêutrons têm sido determinados 

experimentalmente com boa exatidão e são encontrados na literatura (SIMONITS 

et al., 1975 e DE CORTE et al., 1987a). 

O método k0 foi desenvolvido utilizando a convenção de Högdahl 

(HÖGDAHL et al., 1962), a qual assume que a secção de choque (n,γ) varia com 

a lei 1/v na região térmica, isto é, até ∼1,5 eV, para o qual o fator de Westcott é 

igual a 1 (g=1). Para os nuclídeos que não seguem a lei 1/v, o formalismo de 

Westcott (DE CORTE et al., 1993)  é adotado e requer a determinação do índice 

espectral modificado 0)( TTr nα e do fator de Westcott g(Tn), com T0 = 293,6K 

correspondendo à velocidade do nêutron de 2200 m/s, e Tn é a temperatura do 

nêutron para uma distribuição Maxwelliana. 

No método k0 é necessária a caracterização das instalações de 

irradiação e detecção, a utilização de constantes nucleares da literatura (fatores 

k0, Q0 e constantes de desintegração) assim como a determinação de parâmetros 

necessários para o cálculo da atividade das amostras irradiadas (eficiências de 

detecção e intensidades gama).   

A caracterização precisa da instalação de irradiação requer a 

determinação da razão entre os fluxos de nêutrons térmico e epitérmico (f) e do 

parâmetro α relacionado com a distribuição de fluxo de nêutrons epitérmicos, 

aproximadamente dada por 1/E1+α. É uma medida de quanto se afasta o fluxo de 

nêutrons epitérmicos do comportamento ideal 1/E. Estes parâmetros são 

característicos de cada posição de irradiação no reator nuclear.  
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Na caracterização do sistema de detecção, um parâmetro de grande 

importância a ser determinado é a eficiência de detecção no intervalo de energia 

de interesse e a geometria do arranjo experimental.  

 Além disso, as constantes nucleares k0 e Q0 = I0/σ0, onde I0 é a integral 

de ressonância para a reação (n,γ), precisam ser conhecidas para a determinação 

da concentração de um determinado elemento na amostra. 

 Usando o método k0, a concentração (ρ) pode ser calculada por (10): 

 

( ) )(

)(1

,,0,,
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sendo 
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A

m

L
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⋅⋅⋅⋅
=         (11) 

onde: 

Asp – taxa de contagem específica; 

CL – número de contagens líquidas sob o pico de absorção total para a energia 

gama considerada durante o tempo de medida tm.  

m – massa do elemento na amostra ou do comparador irradiados; 

tm – tempo de medida; 

S –  fator de saturação:  ( )iteS λ−−= 1 ; 

λ –     a constante de decaimento; 

ti –  tempo de irradiação, em segundos; 

D –  fator de decaimento: dteD λ−= ; 

td –  tempo de decaimento, em segundos; 

C –  fator de contagem: ( )
m

t

t

e
C

m

λ

λ−−
=

1 ; 

tm –  tempo de medida, em segundos; 

ε – eficiência de detecção de pico da energia Eγ ; 

k0,Au(a) – fator k0 para o isótopo analisado, com referência ao comparador ouro; 

Gth –  fator de correção para auto-blindagem para os nêutrons térmicos; 

Ge – fator de correção para auto-blindagem para os nêutrons epitérmicos; 

f –    razão entre os fluxos de nêutron térmico e epitérmico; 



 

Q0 – razão entre a integral de ressonância (I

nêutrons térmicos (

choque para nêutrons térmicos.

 

 Os subscritos “a” e “Au” referem

respectivamente. 

 

3.1  Espectro de energia dos nêutrons do reator
 

Os feixes de nêutrons abrangem um intervalo bastante amplo de 

energia, podendo variar desde frações de eV até algumas dezenas de MeV. Para 

uma análise mais detalhada do 

nuclear, é conveniente dividir o intervalo de energias em subintervalos (FIG. 3.1). 

Também é importante evidenciar que nos limites extremos desses subintervalos 

há superposições de categorias adjacentes.

 

Figura 3.1 – Distribuição do fluxo de nêutrons de um reator nuclear, 
log (RIZO et al., 1993). 

  

razão entre a integral de ressonância (I0) e a secção de choque para 

nêutrons térmicos (σ0), ou seja, Q0 = I0/σ0, onde σ0 (n,

choque para nêutrons térmicos. 

Os subscritos “a” e “Au” referem-se à amostra e ao ouro, 

3.1  Espectro de energia dos nêutrons do reator 

Os feixes de nêutrons abrangem um intervalo bastante amplo de 

energia, podendo variar desde frações de eV até algumas dezenas de MeV. Para 

uma análise mais detalhada do comportamento dos nêutrons dentro de um reator 

nuclear, é conveniente dividir o intervalo de energias em subintervalos (FIG. 3.1). 

Também é importante evidenciar que nos limites extremos desses subintervalos 

há superposições de categorias adjacentes. 

Distribuição do fluxo de nêutrons de um reator nuclear, ϕ(E) versus E, em escala log
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) e a secção de choque para 

(n,γ) é a secção de 

amostra e ao ouro, 

Os feixes de nêutrons abrangem um intervalo bastante amplo de 

energia, podendo variar desde frações de eV até algumas dezenas de MeV. Para 

comportamento dos nêutrons dentro de um reator 

nuclear, é conveniente dividir o intervalo de energias em subintervalos (FIG. 3.1). 

Também é importante evidenciar que nos limites extremos desses subintervalos 

(E) versus E, em escala log-
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 A classificação dos nêutrons pode ser apresentada da seguinte forma: 

 Nêutrons Térmicos: são nêutrons com energias inferiores a 1eV, e 

que atingem o equilíbrio térmico com os núcleos do meio, após perderem energia 

durante a moderação. De acordo com a distribuição de Maxwell, o número de 

nêutrons por cm3 com energia entre E e E+dE  é  dado por (KAFALA e 

MACMAHON, 1993): 

( )
dEeE
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n
dEEndn kT
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== 2
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2
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2)(

π

π
       (13) 

onde: 

dn – número de nêutrons, em cm-3, com energia entre E e E + dE;  

n – número total de nêutrons, em cm-3;  

n(E) – número de nêutrons por unidade de energia, em cm-3⋅eV-1,para a energia E 

do nêutron; 

k – constante de Boltzmann  = 1,3807×10-23 J⋅K-1 (Physical Reference Data, NIST 

2013); 

T – temperatura, em K. 

 

 Sendo v a velocidade do nêutron e n(v) o número de nêutrons por 

unidade de velocidade, em cm-4s, para a velocidade v do nêutron, a distribuição 

representada pela equação (13) é dada por GLASSTONE e EDLUND (1952). 

                                          kT
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onde:  T0 = 293,16K e m = 1,6749×10-27kg (massa do nêutron) temos que  

                                                  eVkTE 0253,000 ==             (15) 



25 

 

e 

                                                sm
m

E
v /2200

2
0 ≈=             (16) 

 Nêutrons epitérmicos: são nêutrons com energias variando entre 0,5 

eV e 2 MeV, e que se encontram num processo de moderação por meio de 

colisões elásticas. O espectro desses nêutrons em condições ideais (teóricas) 

pode ser descrito pela expressão (17):   

E
E

1
~)(ϕ                                                       (17) 

No entanto, os espectros de nêutrons epitérmicos de irradiações reais 

podem se afastar desse comportamento (HALUK e MUSTAFA, 2004). Foi 

demonstrado que o comportamento desses espectros segue aproximadamente a 

expressão (18): 

                                                      α
ϕ

+1

1
~)(

E
E              (18) 

onde o parâmetro α caracteriza a inclinação na distribuição de nêutrons nessa 

região de energias.  

O limite inferior dessa região é µkT, onde µ é uma constante 

característica do moderador usado no reator. 

Nêutrons rápidos: são nêutrons com energia variando entre 500keV e 

20MeV  e que ainda não sofreram nenhum processo de moderação, pois 

acabaram de ser produzidos na fissão. A distribuição energética característica 

destes nêutrons é denominada espectro de fissão. É possível encontrar na 

literatura (BLATT e WEISSKOPF, 1952) expressões empíricas que apresentam 

uma boa aproximação para a distribuição dos nêutrons de fissão para reatores 

térmicos, como é o caso do reator IEA-R1 do IPEN-CNEN/SP. A mais comumente 

usada é a de Watt dada pela expressão (19):  
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( )EsenheE E 2484,0)( −=ϕ                                (19)                 
 
onde  E é a energia no nêutron em MeV. 
 

 

3.2 Convenções utilizadas no cálculo da taxa de reação 

 

3.2.1 Convenção de Westcott  (WESTCOTT et al., 1958) 

 

 No ano de 1958, C. H. Westcott propôs a convenção que corresponde 

a um método para calcular a taxa de reação, a partir de características do 

espectro e do valor da secção de choque para a reação considerada.  

Esse formalismo proposto por Westcott é um modelo detalhista e muito 

rigoroso que se aplica aos espectros neutrônicos bem termalizados, ou seja, 

quando a razão entre o fluxo térmico e o fluxo epitérmico for muito maior do que a 

unidade (f>>1). A sua principal vantagem é que não requer que os radionuclídeos 

sigam a lei 1/v em todo o intervalo de energia do espectro do nêutron. 

No caso ideal em que se tem um material com secção de choque 

puramente 1/v, pode-se colocar a dependência com a velocidade do nêutron em 

termos da secção de choque térmica: 

v

v
v 00)(

σ
σ =                      (20)  

A magnitude da secção de choque de captura varia muito com a 

energia do nêutron incidente. Dessa forma, a taxa R em que uma dada reação de 

captura ocorre é dada pela equação (21): 

∫∫
∞∞

==
00

)()()()( dEEEdvvvR ϕσϕσ                              (21) 

Assim, a taxa de reação por núcleo alvo, representada pela equação 

(21), pode ser escrita por (22): 
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onde: 

vvnv )()( =ϕ ,                  (23) 

                                        ∫
∞
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  thnv 00 =φ          (25) 

sendo φ0 o fluxo de nêutrons térmicos, em cm-2⋅s-1, para a distribuição de nêutrons 

com velocidade v0 = 2200 m s-1, e nth o número total de nêutrons térmicos, em    

cm-3. 

O fluxo na temperatura real do meio moderador obedece à expressão:  

 

thth nv=φ                 (26) 

onde v é a velocidade média dos nêutrons. Em uma distribuição de Maxwell com 

temperatura T, a velocidade média �D se relaciona com a velocidade v0 pela 

expressão: 

                                               0
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 Substituindo as equações (27) e (25) na equação (26) temos: 
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O que ocorre na prática é que as secções de choque nem sempre 

seguem o comportamento 1/v. Nessas condições, a expressão (28) não 

corresponde a uma aproximação do caso real, tornando-se necessária a 

aplicação de correções para o desvio de 1/v. Essas correções são obtidas de uma 

maneira adequada pela utilização do formalismo de Westcott. 

Para aplicação deste formalismo, considera-se que o espectro de 

nêutrons segue uma distribuição Maxwelliana na região térmica e uma 

distribuição 1/E na região epitérmica. A FIG. 3.1 mostra o comportamento destas 

duas distribuições. A componente 1/E se sobrepõe a Maxwelliana e tem início 

numa certa energia de corte Ec. Essas duas componentes estão relacionadas 

entre si por meio de uma função de junção, ou função de corte. As expressões 

apropriadas para essa função, que tem a finalidade de tornar o espectro contínuo 

na região de junção, podem ser encontradas na literatura. 

Assim, pela convenção de Westcott, a taxa de reação é dada por (29): 

( )rsgnvnvR +== 000 ˆ σσ                          (29) 

onde: 

σ̂ – secção de choque efetiva; 

g – fator de Westcott; 

r – fração de nêutrons epitérmicos; 

s – fator s. 

 A secção de choque efetiva �E representa a soma de uma componente 

térmica (Maxwelliana) e a contribuição do fluxo epitérmico. No caso em que não 

haja contribuição epitérmica (fração de nêutrons epitérmicos f igual a zero), o 

espectro é denominado puramente Mawelliano e a taxa de reação é dada por 

(30): 

gnvnvR m 000 ˆ σσ ==                  (30) 

e mσ̂  é a  secção de choque efetiva Maxwelliana ( gm 0ˆ σσ = ). No caso em que o 

espectro não seja puramente Maxwelliano, em que existe uma certa fração do 
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espectro epitérmico sobreposto ao térmico, a taxa de reação é a dada pela 

equação (29). 

Com o formalismo de Westcott, é possível definir um fator de correção 

g (fator de Westcott) que permite obter a secção de choque Maxwelliana efetiva 

�EF. Este fator g tem a finalidade de corrigir a secção de choque efetiva �EF para a 

influência da temperatura e para a variação da secção de choque na região 

Maxwelliana. Os valores de g para diversos materiais e temperaturas podem ser 

encontrados na literatura, assim como é possível se encontrar valores para σo. 

 O parâmetro r representa a fração de nêutrons epitérmicos e o fator S 

é uma quantidade dependente da temperatura relacionada com a integral de 

ressonância reduzida. 

Através do formalismo de Westcott, para se obter o fluxo convencional, 

basta isolar o fator nv0 da equação (29): 

( )rsg

R

+
=

0σ
φ                                (31) 

 

3.2.2 Convenção de Högdal 
 

A introdução desta convenção nos parâmetros do k0-INAA foi realizada 

por De Corte e Simonits em 1989 (DE CORTE e SIMONITS, 1989). Apesar de as 

convenções de Westcott e Stoughton-Halpering serem mais gerais, Högdal 

considerou que realmente são poucos os radionuclídeos que não cumprem a lei 

v

1
~σ . Esta convenção baseia-se no fato experimental de que, se uma amostra é 

irradiada em uma cápsula de cádmio de 1 mm de espessura, a cápsula absorverá 

completamente os nêutrons de energias inferiores a ECd = 0,55 eV (subcádmicos), 

deixando passar livremente os de energias superiores (epicádmicos). Assim, a 

taxa de reação por núcleo, de acordo com Högdal, é dada por: 
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onde  
n

Cd
Cd

m

E
v

2
= é velocidade do nêutron correspondente à energia de corte do  

cádmio (ECd = 0,55eV). Para reações (n, γ) sem ressonâncias abaixo de 0,55eV (o 

que significa fator de Westcott g = 1) a dependência com a relação 1/v, descrita 

na equação (20) pode ser aplicada para a velocidade do nêutron abaixo de vCd. 

Substituindo as equações (20) e (23) na equação (32) temos: 
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onde o fluxo de nêutrons térmicos convencional, φth, em cm-2⋅s-1, é dado por: 

                                                   ∫=
Cdv

th dvvnv
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0 )(φ             (34)  

A última integral da equação (32) pode ser escrita por: 
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Considerando-se, da equação (18), que 
α
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E , para energias 

maiores que 0,35eV, o fluxo de nêutrons epitérmico é descrito por (DE CORTE, 

1987b): 
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onde  Eref  é uma energia de referência escolhida arbitrariamente (usualmente, por 

convenção, 1eV). Substituindo a equação (36) na equação (35) vem:                 
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onde: 

I0(α) – integral de ressonância; 
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φe – fluxo de nêutrons epitérmicos convencional, em cm-2⋅s-1. 

 

com 

                                       ∫
∞

+
=

CdE

ref dE
E

E
EI

α

α

σα
10

)(
)()(         (38) 

e 

refrefee EE )(ϕφ =             (39) 

Substituindo as equações (44) e (48) na equação (43) é possível 

escrever a taxa de reação por núcleo alvo por: 

                                          )(00 αφσφ IRRR etheth +=+=      (40) 

Assim, a taxa de reação é uma composição das contribuições dos 

nêutrons térmicos e epitérmicos. 

 

3.3 Comparadores e parâmetros de fluxo (k0-IAEA, 2007) 

 

 No método k0-INAA, os seguintes parâmetros de fluxo são necessários 

para caracterizar uma estação de irradiação e as taxas de reação (n, gama): 

� O primeiro parâmetro é a razão entre o fluxo térmico e epitérmico (φth/φe) 

chamada de f. Quanto maior a termalização, maior será o valor de f. 

� O segundo parâmetro é o α, que é o índice de não-idealidade do espectro 

de nêutrons epitérmicos. 

� O terceiro parâmetro é a temperatura da velocidade de distribuição de 

Maxwell-Boltzmann, que descreve a componente térmica do espectro de 

nêutrons.  

 No programa k0-IAEA, existe um quarto parâmetro, o fluxo rápido. Além 

disso, o significado de alguns dos parâmetros é um pouco diferente do que no 

método k0 original. 
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3.3.1 Estratégias na caracterização das instalações de irradiação 

– escolha do comparador 

 

 Pode-se considerar que o fluxo de nêutrons rápidos e o fluxo de 

nêutrons térmicos são proporcionais um ao outro num recipiente de irradiação - 

ambos podem variar de um dia para o outro e de um ponto para outro. Além 

disso, pode-se admitir que os valores de f e α não variam no recipiente de 

irradiação, e nem mesmo em diferentes dias. Isto significa que é muito seguro 

determinar f, e α, a relação de nêutrons rápidos por térmicos, apenas 

periodicamente. O fluxo térmico, no entanto, deve ser determinado toda vez, a 

cada irradiação, com os comparadores de cada lado da amostra a ser analisada. 

Um comparador apropriado para uma caracterização completa do espectro de 

nêutrons necessita conter um certo número de isótopos (k0-IAEA, 2007). Uma 

mistura clássica contém Au, Zr, Lu e Fe. Para determinar apenas o fluxo térmico, 

qualquer elemento que dê origem a um radioisótopo apropriado pode ser usado. 

Os elementos mais utilizados são Au, Zn e Fe. No presente trabalho, o 

comparador utilizado foi o Au (Al-0,1%Au - Certified Reference Material IRMM-

530R). Outros laboratórios têm utilizado outros elementos, como Zn na forma de 

solução (BLAAUW et al., 1993). No Instituto Peruano de Energia Nuclear (IPEN), 

desde a implementação do método do k0-INAA, uma solução de sódio tem sido 

utilizada como comparador, devido ao seu melhor desempenho ao 

comportamento não-ideal do fluxo de nêutrons epitérmicos (BEDEGRAL et al., 

2010). 

 

3.4  Determinação do parâmetro f 
 

Dos vários métodos para determinação da razão entre os fluxos 

térmico e epitérmico, dois são os mais usados de forma experimental, em 

qualquer canal de um reator: são os métodos da razão de cádmio e o multi-

isotópico.  
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a) Método da razão de cádmio: 

 

                   ( )
th

e
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G

G
QRFf )(1 0 α−=                          (41) 

onde  

RCd – a razão de cádmio (razão entre a atividade específica do radionuclídeo 

irradiado sem cobertura de cádmio e a atividade específica do radionuclídeo 

irradiado com cobertura de cádmio); 

FCd – fator de transmissão epitérmica do cádmio. 

com 

                                                      
e

Cd
R

R
R =              (42) 

Para obtenção das taxas de reação R e Re, as amostras não devem 

ser irradiadas simultaneamente, uma vez que o cádmio pode causar pertubações 

significativas em suas vizinhança, alterando o fluxo de nêutrons.  

 

b) Método dos monitores bi-isotópicos descobertos 
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onde  

Ge,1, Gth,1, k0,c(1) e Asp,1 referem-se ao 97Zr/97mNb (743,3keV); 

Ge,2, Gth,2, k0,c(2) e Asp,2 referem-se ao 95Zr (724,2keV); 

Ge,3, Gth,3, k0,c(3) e Asp,3 referem-se ao 198Au (411,8keV); 
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A TAB. 3.1 mostra os monitores mais usados para determinação da 

relação f pelo método do monitor bi-isotópico sem cádmio, necessária para a 

aplicação do método de padronização k0. 

Tabela 3.1 – Dados nucleares dos radionuclídeos mais importantes usados como monitores para 
determinação dos parâmetros α e f (DE CORTE e SIMONITS, 2003). 

Radionuclídeo σ0 (barn) I0 (barn) Q0(I0/σ0) T1/2 
198Au 98,65 1550 15,71 2,695 (d) 

60Co 37,2 72,6 1,952 5,271 (a) 

95Zr 0,053 0,268 5,057 64,03 (d) 

97Zr 0,021 5,28 251,42 16,74 (h) 

51Cr 15,2 8,1 0,53 27,69 (d) 

99Mo/99mTc 0,131 6,96 53,13 66,02 (h) 

 

3.5  Determinação do parâmetro αααα 

 

Os métodos experimentais para determinação do parâmetro α (DE 

CORTE et al., 1987a; DE CORTE, 1987b) podem ser classificados em três 

grupos: Método da Razão de Cádmio com Monitores Múltiplos (“Cd-ratio multi-

monitor method”), Método de Monitores Múltiplos Cobertos Com Cádmio (“Cd-

covered multi-monitor method”) e o Método dos três monitores descobertos (“Bare 

triple monitor method”).  

O comportamento ideal do fluxo de nêutrons epitérmicos é descrito 

pela função 1/E onde E é a energia do nêutron, mas distorções podem alterar 

esse comportamento, para um caso real. Apesar disto, o espectro ainda pode ser 

descrito aproximadamente pela função 1/E1+α, onde α é uma medida do quanto se 

afasta o fluxo de nêutrons epitérmicos do comportamento ideal e é característico 

de cada posição de irradiação do reator. Na literatura internacional, se reportam 

tanto valores positivos como negativos de α (DE CORTE et al., 1984) comparados 

com o caso ideal, como se ilustra na FIG. 3.1. 

A representação 1/E1+α induz à necessidade de se realizar 

determinadas correções à integral de ressonância (e aos resultados analíticos) 

para um fluxo de nêutrons epitérmicos não ideal (DE CORTE et al., 1986). Dessa 
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forma, para manter a precisão e exatidão da análise, o parâmetro α deve ser 

conhecido, quando se realiza o cálculo da concentração de um elemento em uma 

determinada amostra. 

 

3.5.1 Método de razão de cádmio em multimonitores 
 

Neste método, dois conjuntos de n monitores são irradiados: um 

conjunto com uma cobertura de cádmio e outro conjunto sem cobertura de 

cádmio, nas mesmas condições de fluxo de nêutrons. Após as irradiações, a 

razão de cádmio dos monitores é determinada para cada um dos monitores e o 

parâmetro α é obtido pela inclinação (-α) da curva dada por (DE CORTE, 1987b): 

                                                     
ii XaY α+=                    (44) 
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                                                        iri EX ,log=          (45) 
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onde irE ,  é a média das energias de ressonância na secção de choque de 

absorção de nêutrons para o alvo i. 

 

3.5.2  Método de multimonitores cobertos com cádmio 

 

Neste método, um conjunto de monitores é irradiado com uma 

cobertura de cádmio e as atividades dos radionuclídeos são determinadas por 

meio de um espectrômetro de HPGe, calibrado em eficiência. Considerando que 

as secções de choque de captura de nêutrons dos monitores se comportem de 

acordo com a lei 1/v na região térmica, o parâmetro α é obtido pela inclinação (-α) 

curva dada pelas equações (44) e (45) com Yi dado por (DE CORTE, 1987b) 
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Como no método anterior, o parâmetro α pode ser obtido por meio de 

um ajuste, aplicando-se o método dos mínimos quadrados com matriz de 

covariância (CARDOSO, 2011). 

 

3.5.3  Método dos três monitores descobertos 
 

Neste método, um conjunto de dois monitores juntamente com um 

monitor de referência, é irradiado sem cobertura de cádmio. Logo depois de 

serem irradiados, as atividades induzidas são medidas utilizando um detector de 

HPGe com uma curva de eficiência bem determinada. A TAB. 3.1 mostra os 

monitores (95Zr, 97Zr e 198Au) e os respectivos dados nucleares (DE CORTE e 

SIMONITS, 2003) relevantes para determinação do parâmetro α utilizando-se o 

método “bare triple monitor”. De acordo com este método, o parâmetro α pode ser 

calculado resolvendo-se numericamente a seguinte equação (DE CORTE et al., 

1979) 
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Normalmente, neste método, são utilizados os radionuclídeos 97Zr, 95Zr 

e 198Au. Neste caso, o índice 1 corresponde ao isótopo 97Zr/97mNb (743,3 keV), o 

índice 2 ao isótopo 95Zr (724,2 + 756,7 keV) e o índice 3 ao isótopo 198Au (411,8 

keV). 

 

3.6  O PROGRAMA k0-IAEA (ROSSBACH et al., 2007) 

Nos últimos anos, a Agência Internacional de Energia Atômica (AIEA) 

tem ajudado muitas instituições em seus Estados-Membros, por meio da 

assistência através da cooperação técnica e projetos de pesquisa coordenados, 

serviços de especialistas e bolsas de estudo. Alguns desses laboratórios como 

Institute of Nuclear Chemistry and Technology (INCT), na Polônia, Malaysian 

Nuclear Agency (MNA), Malásia, Interfaculty Reactor Institute of Technology (IRT), 

da Delft University of Technology, Holanda, o Instituto Nuclear Tecnológico (ITN), 

em Portugal entre outros, têm estabelecido boas práticas de laboratórios e bons 

sistemas de qualidade e estão prestando serviços a clientes nas diversas áreas 

da ciência. Devido às suas vantagens experimentais, a Análise por Ativação com 

Nêutrons (NAA) é o carro-chefe desses laboratórios, A automação do processo de 

contagem e avaliação de dados para aumentar o rendimento das amostras e 

padronização do procedimento é um grande desafio em muitos laboratórios de 

NAA. Em um passado recente, foram desenvolvidos programas utilizando o 

método do k0 para aplicação em NAA em vários laboratórios usando diferentes 

tipos de abordagens. Este método agora está bem estabelecido na comunidade 

analítica nuclear, embora o catálogo de dados para uso do k0 esteja sob 

constante refinamento de cálculo e as rotinas básicas para a avaliação do 

elemento na amostra usando o k0 precise ser vinculado de forma adequada. Um 

pacote de programa comercial para essa finalidade está disponível (Kayzero for 

Windows, 2008), mas é muito oneroso para vários laboratórios de pesquisas.  

Um programa com interface de usuário para o ambiente Windows foi 

desenvolvido para ser distribuído gratuitamente pela Agencia Internacional de 

Energia Atômica (IAEA), a fim de incentivar ainda mais o uso do k0 em 

laboratórios de analise por ativação com nêutrons (NAA). O programa k0-IAEA 

deve promover a harmonização dos resultados analíticos de laboratórios de NAA, 
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eliminando erros relativos aos cálculos dos resultados bem como as dificuldades 

de preparação de padrões. Para validar o método, utilizou-se o material de 

referência SMELS (EGUSKIZA et al., 2003), e a caracterização das instalações 

de irradiação.   

Prevê-se para um futuro próximo incorporar módulos adicionais no 

programa k0-IAEA, como a determinação da área dos picos tornando os dados de 

entrada menos pesados e a implementação de PGNAA. Um catálogo para valores 

de k0 para reações prompt gamma está disponível (BLAAUW, 1994), a crescente 

comunidade PGNAA irá apreciar a opção de usar o mesmo programa para 

espectros de gama rápido e retardados para interpretação simultânea de 

espectros desta natureza. Este novo programa, devido à abordagem holística 

universal, pode acomodar tais diversas aplicações e será disponibilizado para 

uma grande comunidade de usuários de técnicas analíticas nucleares. 

O banco de dados principal utilizado foi o banco de dados k0 (DE 

CORTE e SIMONITS, 2003 e BLAAUW, 1996), disponível no site do k0 The official 

k0 website, www.k0naa.org (ROSSBACH et al., 2007) e complementado com o 

banco de dados em uso no Interfaculty Reactor Institute em Delft. Também são 

necessários os esquemas de decaimento dos radionuclídeos. Estes foram 

retirados da Tabela de Radionuclídeos (FIRESTONE, 1996). 

O algoritmo que realiza esses cálculos no programa leva em conta 

fenômenos como escape, escape duplo, efeito de soma em cascata entre os raios 

gama ou que envolvem raios-X após a captura de elétrons ou conversão interna. 

As exceções são as correlações angulares, as perdas devido à coincidência 

Bremsstrahlung e, finalmente, não são feitas correções para as contagens de 

fontes não pontuais próximas ao detector. 

Uma mistura de métodos é incorporada no programa k0-IAEA composto 

por uma abordagem proposta por De Felice, (DE FELICE et al., 2000) onde uma 

medida de, por exemplo, 137Cs, é empregada para determinar a eficiência total 

dos picos e da abordagem de Delft (BLAAUW, 1993a e 1993b), que é usada para 

o ajuste da curva de eficiência, sabendo a eficiência total dos picos e levando em 

conta o efeito soma em cascata.  
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Originalmente, o método k0 foi baseado na Convenção de Högdahl. 

Blaauw adaptou essa convenção, removendo todas as referências da energia de 

corte do cádmio das formulas do k0 (BLAAUW et al., 1991). 

O programa k0-IAEA leva em conta as reações threshold, tipo [(n,p), 

(n,2n), (n,α), ...]. Qualquer número de espectros de amostras obtidas após 

qualquer número de irradiações podem ser interpretadas simultaneamente com o 

programa, uma vez que utiliza o método de interpretação holística (BLAAUW, 

1993b e 1994). O programa utiliza todos os monitores de fluxo para encontrar os 

parâmetros aplicáveis a uma amostra em particular ajustando uma linha reta, ou 

se necessário uma hipérbole, para os valores dos parâmetros observados em 

função da posição no recipiente de irradiação. 

Um roteiro e um vídeo para utilizar o programa k0-IAEA estão descritos 

nos ANEXO 1 e 2. 
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4. MATERIAIS E MÉTODOS 

 

4.1 Determinação das curvas de eficiência de detecção dos raios 

gama em detector de Ge hiperpuro 

  

 Para a determinação das curvas de eficiência de detecção dos raios 

gama utilizando o programa k0-IAEA foi necessário, primeiramente, descrever 

minuciosamente a geometria de contagem do sistema de espectrometria gama 

(FIG. 4.1) utilizado nas medidas, pois o programa leva em conta medidas como o 

tamanho do cristal, as dimensões do porta amostra de lucite onde a amostra é 

medida, as dimensões do porta amostra de aço inox (panelinha), as distâncias, do 

suporte de lucite, da fonte até o cristal entre outros parâmetros, como é visto nas 

FIG. 4.2 a 4.5, e na TAB. 4.1. A FIG. 4.6 mostra como a caracterização foi 

inserida na base de dados permanente do programa k0-IAEA. 

 Foram construídas as curvas de eficiência do detector de Germânio 

hiperpuro, chamado Canberra 3, modelo GX2020, número de série 3975069, 

Criostato Modelo 7500SL, com resolução de 1,14 keV para o pico de 122,06 keV 

do 57Co e 2,07 keV para o pico de 1332,5 keV do 60Co, ligado a uma placa 

multicanal, S100, em um microcomputador disponível no LAN-IPEN. O software 

de aquisição e análise utilizado foi o Genie 2000 Virtual Data Manager. 

 O microcomputador existente apresentava variação no horário na sua 

configuração, assim, durante a realização do trabalho foi substituído esse 

aparelho por outro no qual não apresentava esse problema.  
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FIGURA 4.1 – Sistema de espectrometria gama (Canberra 3) 

 
 
 
 
 
 

   
FIGURA 4.2 – Suporte utilizado nas medidas com diferentes posições/prateleiras de contagem 
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FIGURA 4.3  – Dimensões (mm) do suporte das prateleiras  

  
FIGURA 4.4 – Porta amostras de lucite com degrau em mm  
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                                        FIGURA 4.5 – Dimensões do detector (k0-IAEA, 2007) 
 
 
 
 
 
 
TABELA 4.1 – Dimensões do detector de germânio hiperpuro do sistema de espectrometria gama 

Canberra3. As medidas de A até H são referentes às dimensões da FIG. 4.5 

 Dimensões (mm) 

A Diâmetro do cristal 53 
B Comprimento do cristal 45 
C Espessura da Camada morta 0,71 
D Distância da tampa até o cristal 5 
E Diâmetro da tampa superior 75 
F Espessura da tampa superior 2,87 
G Diâmetro do núcleo 7,5 
H Altura do núcleo 30 
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FIGURA 4.6 - Dimensões do sistema Canberra3 no programa k0-IAEA 

 

 O segundo passo foi medir as atividades de fontes radioativas de 

energias de raios gama e atividades conhecidas. As fontes foram medidas na 

posição 3 (posição referência), com o suporte de lucite com degrau e com o porta- 

amostra de aço inox, e a radiação de fundo foi medida com o suporte de lucite 

para a posição zero sem fonte de calibração, com o porta amostra de aço inox 

colocada na posição 0, como mostra a TAB. 4.2.  

 
TABELA 4.2 - Posição e tempo de contagem das fontes para calibração 

Fonte Prateleira Tempo 
137Cs 3 1200s 
152Eu 3 5400s 

Background --- 15h 

 
 

TABELA 4.3 - Distância da fonte até o cristal nas diversas prateleiras do detector Canberra 3  

Prateleira Distância do detector 
(mm) 

0 8,5 ± 0,05 
1 35,4 ± 0,05 
2 66,4 ± 0,05 
3 94,8 ± 0,05 
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  O detector utilizado possui quatro posições de medida, como mostram 

as FIG. 4.2 e 4.3. As fontes utilizadas foram 137Cs (Certificado n° AI-010/91, n° de 

referência 37044, data 01/10/1991, atividade 75200±1880 Bq,  IPEN-CNEN/SP) e 
152Eu (Certificado n° AI-023/97, n° de referência 52036, data 01/09/1997, atividade 

7580±227 Bq, IPEN-CNEN/SP). Essas fontes permitem determinar a curva de 

eficiência do espectro de raios gama. A curva de eficiência, ajustada por meio do 

programa k0-IAEA, a uma distância do detector de  94,8cm para o Canberra 3, 

está apresentada na FIG. 4.7. 

 

 
FIGURA 4.7 - Curva de eficiência para o sistema de espectrometria gama Canberra 3 (94,8 mm do 

detector) pelo programa k0-IAEA 

 

4.2 Descrição do reator nuclear IEA-R1  

 

 O reator IEA-R1 é um reator nuclear de pesquisa do tipo piscina, 

contendo 273 m3 de água desmineralizada, com moderação e refrigeração a água 

leve, utilizando como refletores berílio e grafite e operando com potência máxima 

de 5 MW. A piscina tem cerca de 9 m de profundidade, por 3 m de largura e 11 m 

de comprimento (GONÇALVES, 2006).  
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O núcleo do reator encontra-se dentro da piscina e está montado em 

uma placa motriz com oitenta orifícios, na qual é possível que os combustíveis 

sejam dispostos em vários arranjos experimentais (FIG. 4.8). Essa placa motriz é 

sustentada por uma treliça conectada a uma plataforma móvel, onde estão 

montados os quatro mecanismos de acionamento das barras e detectores que 

enviam sinais para a mesa de controle (BUENO, 2006). 

A FIG. 4.10 mostra o mapa de configuração do núcleo do reator IEA-

R1, durante as irradiações realizadas no presente trabalho. Para este estudo, foi 

escolhida a posição de irradiação Posição 24B/Prateleira 2. A potência utilizada 

durante as irradiações efetuadas no presente trabalho foi 4,5MW.  

Para irradiações longas, períodos maiores que 5 minutos, as amostras 

com até 1 grama são pesadas em envelopes de polietileno e encapsuladas em 

coelhos de cilíndricos alumínio (FIG. 4.9) e irradiadas nos dispositivos de 

irradiação do reator IEA-R1. 

 De acordo com uma conversa pessoal realizada com o funcionário 

Tonicarlos de Lima, responsável pelas irradiações do reator IEA-R1, para 

correção do tempo de irradiação é necessário acrescentar em 15s. Esse tempo é 

referente à locação da amostra na prateleira (10s) e da retirada da amostra da 

prateleira (5s). Esse é um valor estimado podendo variar conforme o operador 1. 

 
 
 

 

                                                           
1
 Lima, T. Comunicação pessoal, 2013. 
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FIGURA 4.8 - Reator IEA-R1 do IPEN-CNEN/SP 
 

 

 

 

 

 

 

 

 
FIGURA 4.9 – Recipiente de irradiação utilizado na para irradiações longas no núcleo do reator 

IEA-R1 
 

 



48 

 

 

 
FIGURA 4.10  – Mapa da configuração do núcleo do reator IEA-R1. Estão em destaque a posição 

24B prateleira 2 e a posição da estação pneumática, utilizada neste trabalho 

 

4.2.1 Estação pneumática de irradiação  

  

O reator IEA-R1 do IPEN-CNEN/SP possui uma estação pneumática 

para irradiações de curta duração. Esse tempo pode ser de alguns segundos a 5 

minutos no máximo. A estação é ligada ao reator por meio de um tubo 

pneumático (FIG. 4.11). As amostras são enviadas para irradiação 

pneumaticamente e são trazidas após a irradiação automaticamente. O tempo de 
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transferência entre a estação e a posição de irradiação é de aproximadamente 

12s em recipientes de irradiação (coelhos) de polietileno (FIG. 4.12). Na estação 

pneumática, amostras de diversas matrizes, com massa de até 1g, são pesadas 

em envelopes de polietileno (saquinhos) e encapsuladas nos coelhos cilíndricos 

de polietileno e enviadas para irradiação. No presente estudo foi feito um 

sanduíche, envolto com papel, contendo uma amostra biológica e um monitor de 

ouro (FIG. 4.13 e 4.14).   

A particularidade dessa estação pneumática é o fato de que o efetivo 

tempo de irradiação é defasado em 2s; ou seja para obter um tempo de irradiação 

de 30s é necessário colocar no temporizador 32s. Isso ocorre pois a amostra ao 

acionar o sensor, o qual instantaneamente indica ao temporizador o tempo de 

inicio da irradiação, percorre aproximadamente de 2s para chegar ao centro da 

posição de irradiação. Depois que a amostra sai da posição de irradiação é 

desarmado instantaneamente o sensor do temporizador, assim não existindo a 

necessidade de colocar mais 2s para correção do tempo de irradiação. 

 

 

FIGURA 4.11 – Sistema pneumático de irradiação de amostras no reator IEA-R1 (MARIANO, 
2012) 
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FIGURA 4.12 – Recipiente de irradiação utilizado na estação pneumática do reator IEA-R1 

 

 

 

 

 

 

 

 
FIGURA 4.13 – Sequência para obter o “sanduíche” irradiado na estação pneumática do reator 

IEA-R1. Primeira parte mostra a amostra biologica e o monitor de ouro; a segunda parte mostra o 
monitor e a amostra envoltos no papel; e a terceira parte mostra ambos contidos no recipiente de 

polietileno. 
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FIGURA 4.14 – Vista interna do recipiente de polietileno com a amostra biológica e os monitor de 

ouro. 
 

 
 

4.3 Determinação dos parâmetros de fluxo 
 

 Para se determinar os parâmetros α e f para a estação pneumática e 

para a  posição 24B prateleira 2 do reator nuclear IEA-R1, foram utilizados os 

monitores certificados de Zr 0,25 mm de espessura e 99,8% de pureza (Zr-foil),  

produzido por Aldrich Chemical Company, cortado em formato de disco, 

juntamente com um fio de uma liga Al-0,1%Au (Certified Reference Material 

IRMM-530R), de 1 mm de diâmetro. Os tempos de irradiação e massas dos 

monitores foram: 

� Estação pneumática: tempo de irradiação 2 minutos; massa dos monitores 

Zr (44,72 mg) e Au (8,56 mg). As medidas foram realizadas após 2 horas 

do início da irradiação.  

� Posição 24B prateleira 2: tempo de irradiação 4 horas; massa dos 

monitores Zr (44,61 mg) e Au (7,88 mg). As medidas foram realizadas após 

2 dias do início da irradiação. 

 Após tempos de decaimento apropriados, os monitores foram medidos 

no detector HPGe, caracterizado, chamado Canberra3. Todas as medições foram 
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realizas na posição referência do detector, 94,8mm. Este valor é referente à 

distância da fonte até o cristal do detector (TAB. 4.3). 

 Após as medidas, os espectros foram introduzidos no programa          

k0-IAEA e analisados; posteriormente, o programa k0-IAEA calculou os 

parâmetros α e f.  

 A temperatura neutrônica foi determinada pela irradiação de 3 mg de 

uma folha de  Lu de 0,1016 mm de espessura e 99,963% de pureza (Reactor 

Experiments, Inc.) (MARIANO, 2011). Os dados nucleares das três reações 

nucleares 197Au (n, γ) 198Au, e 94,96Zr (n, γ) 95,97Zr estão resumidos na TAB. 4.4.  

 

TABELA 4.4 – Dados nucleares usados na caracterização do fluxo de nêutrons (DE CORTE e 
SIMONITS, 2003). 

Reação Nuclear Q0 (σ,%) Er (eV) �G HI  Eγ (keV) k(0,Au) (σ,%) 

94Zr�B, C�95Zr 5,31 (3,3) 6260 64,02 dias 724,2 + 756,7 2,00E-4 (1,2) 
96Zr�B, C�97Zr 251,6 (1) 338 16,74 horas 743,4 1,24E-5 (0,3) 

197Au�B, C�198Au 15,7 5,65 2,69 dias 411,8 1 

 

 Os tempos de irradiação e decaimento foram cuidadosamente 

controlados, pois esses parâmetros são muito significativos no método do k0-

INAA, principalmente quando se trata de irradiações curtas. Várias medidas foram 

realizadas de modo a se obter um conjunto de espectros adequado para o cálculo 

dos parâmetros f and α pelo programa k0-IAEA. Após as medidas, os dados foram 

introduzidos no programa k0-IAEA e analisados.   

 No programa k0-IAEA, os monitores de Al-0,1%Au e Zr são medidos 

juntos, como uma única liga, colocados um sobre o outro no porta-amostra de aço 

inox. As TAB. 4.5 e 4.6 mostram como foram realizados os cálculos dessa única 

liga de Zr e Au, para a irradiação na Estação Pneumática e para Posição 

24B/Prateleira 2. A quantidade do elemento é calculada pelo produto da 

multiplicação da massa pela pureza (concentração); a concentração de referência 

em mg/kg é obtida pelo quociente da divisão da quantidade pela massa total 

multiplicado pelo fator 106.. O valor da concentração de referência em mg/kg é 
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utilizado para o cadastramento do material certificado no programa k0-IAEA (FIG. 

4.15 e 4.16). 

 Em outros trabalhos, tem-se utilizado alguns tipos de mistura de 

monitores, como o par 51Cr-99Mo/99mTc com período de período de semi-

desintegração de 27,69 dias e 66,02 horas respectivamente (HERRERA et al., 

1992), bem com a mistura 60Co-99Mo-198Au, com período de semi-desintegração 

de 5,27 anos, 66,02 horas e 2,69 dias (MONTOYA et al., 2009). Para a 

caracterização dos valores de α, f, e temperatura neutrônica, foi utilizado o 

comparador com Au e Zr na estação pneumática e na posição 24B/prateleira 2. 

 

TABELA 4.5 – Concentração dos monitores para irradiação na estação pneumática. 

Monitor Massa 
(mg) 

Elemento Concentração Quantidade 
(mg) 

Concentração 
de Referência 

(mg/kg) 

Au 8,56 
Au 0,100% 0,00856 161 

Al 99,900% 8,55144 160770 

Zr 44,72 Zr 99,800% 44,63056 839069 

Massa total 53,19056  

 
 

TABELA 4.6 – Concentração dos monitores para irradiação na posição 24B prateleira 2. 

Monitor 
Massa 
(mg) Elemento Concentração 

Quantidade 
(mg) 

Concentração 
de Referência 

(mg/kg) 

Au 7,88 
Au 0,100% 0,00788 150 

Al 99,900% 7,87212 150229 

Zr 44,61 Zr 99,800% 44,52078 849621 

Massa total 52,40078  
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FIGURA 4.15 – Monitores de Au+Zr da estação pneumática cadastrados na base de dados 

permanente do programa k0-IAEA. 

 

 
FIGURA 4.16 – Monitores de Au+Zr da posição 24B/prateleira 2 cadastrados na base de dados 

permanente do programa k0-IAEA. 
 



55 

 

 

 

4.4  Análise dos materiais de referência 

  

 Os materiais biológicos de referência (cerca de 150mg) SRM 1547 

Peach Leaves, INCT-MPH-2 Mixed Polish Herbs e SRM 1573a Tomato Leaves  

foram irradiados juntamente com cerca de 8 mg do monitor de Al-0,1%Au na 

estação pneumática do reator e na posição 24B/prateleira 2 do IEA-R1 do IPEN-

CNEN/SP. A porcentagem de umidade dos materiais de referência foi 

determinada conforme as informações contidas nos certificados dos materiais de 

referência e, no cálculo da concentração pelo método do k0, foi feita a correção 

para a massa seca. Os valores descriminados nas TAB. 5.4 a 5.6 foram obtidos 

através de seis análises em repetição de cada material de referência. Na estação 

pneumática, o tempo de irradiação das amostras foi de 60 segundos. Para a 

contagem dos materiais de referência biológicos e monitores, irradiados na 

estação pneumática, foram realizadas medidas sistemáticas conforme 

apresentado na TAB. 4.7, para melhor reprodutibilidade dos resultados. 

 Na irradiação das amostras para a obtenção de elementos que 

originam radionuclídeos de meia-vida longa, foram estabelecidas 10 horas como 

tempo de irradiação e duas séries de medidas da atividade induzida. Para a 

contagem dos materiais de referência biológicos e monitores, foram realizadas 

medidas sistemáticas conforme apresentado na TAB. 4.8, para melhor 

reprodutibilidade dos resultados.  

Para a irradiação de cada amostra, na posição 24B/ prateleira 2, foi 

realizado o seguinte procedimento (FIG. 4.18 e 4.19): 

� As amostras biológicas e os monitores de ouro foram pesados em 

envelopes de polietileno (FIG. 4.17); 

� Envolveram-se cada um desses materiais em folha de alumínio;  

� Posteriormente foram empilhados esses materiais, envolvendo-os com 

folha de alumínio, intercalando as amostras biológicas e os monitores de 

ouro um a um em formato de sanduíche.  

� Por fim, foi alocado esse sanduíche no coelho de alumínio.  
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FIGURA 4.17 – Materiais certificados biológicos e monitores pesados em envelopes de polietileno. 
 

 

FIGURA 4.18 –  Sequência para obter o “sanduíche” irradiado na posição 24B/prateleira 2 do 
reator IEA-R1. Primeira parte mostra a amostra biologica e o monitor de ouro envoltos na folha de 

alumíno; a segunda parte mostra as 6 amostras biológicas intercaladas com os 5 monitores de 
ouro; e a terceira parte mostra todos os materiais envoltos na folha de alumínio e a quarta parte 

mostra o sanduíche contido no recipiente de alumínio. 
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FIGURA 4.19 – Vista interna do recipiente de alumínio com as amostras biológicas e os monitores 
de ouro  

 

TABELA 4.7 – Condições de contagem dos elementos  irradiados na estação pneumática 

 Início da contagem após 
a irradiação 

Tempo  
de contagem 

Material Biológico 
Certificado  5min 240s 

Material Biológico 
Certificado 15min 600s 

Material Biológico 
Certificado 30 min 900s 

Monitor de Au 2h 7200s 

Material Biológico 
Certificado 12h 10800s 

 

 

TABELA 4.8 – Condições de contagem dos elementos irradiados na posição 24B/prateleira 2 

 Início da contagem após 
a irradiação 

Tempo  
de contagem 

Material Biológico 
Certificado  

5 a 7 dias                      
(1ª contagem) 7200s 

Monitor de Au 5 a 7 dias                      
(1ª contagem) 3600s 

Material Biológico 
Certificado 

10 a 15 dias                      
(2ª contagem) 7200s 
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4.5 Avaliação estatística dos resultados obtidos para os materiais 

de referência  

 

Para avaliar os resultados obtidos nesse trabalho, os valores encontrados 

foram comparados aos valores recomendados, utilizando três critérios: 

Coeficiente de Variação (CV), para avaliar a reprodutibilidade do método, Erro 

relativo (bias, %) e o teste U-score (para os elementos que possuíam valores 

certificados), para avaliação da exatidão do método. 

 A seguir, será feita uma descrição mais detalhada destes critérios 

estatísticos. 

 

4.5.1 Erro relativo (bias, %), coeficiente de variação (CV) e teste 

U-score 

  

 A exatidão, definida como a concordância entre o valor real do analito 

na amostra e o estimado pelo processo analítico (FRANCOTTE et al., 1996; 

BRITO et al., 2001; GONZÁLES et al., 1999), constitui a chave para o propósito 

da validação de um método. Neste trabalho, a exatidão foi avaliada por meio do 

erro relativo (bias, %) de acordo com a expressão (52). 

 

JKLM,% �   |PQRS :PTUVW |PTUVW  X 100                                                   (52) 

 

onde: 

xLab – valor obtido com a média aritmética das replicatas  

xcert – valor certificado no material de referência 

 

 O parâmetro que avalia as proximidades entre várias medidas 

efetuadas na mesma amostra é a precisão do processo analítico (BRITO et al., 

2005). Usualmente, é expressa como o desvio-padrão, variância ou coeficiente de 

variação de diversas medidas (HUMBERT et al., 1999; PERSSON STUBBERUD 
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e ASTROM, 1998). O coeficiente de variação (CV) ou desvio padrão relativo é 

dado pela expressão (53).  

 

CV (%) = Z[\]^      (53) 

onde: 

s – valor do desvio padrão das replicatas 

_D – valor da média aritmética das replicatas.  

 

 Segundo WOOD, (1999), o desvio padrão relativo está relacionado 

com o nível de concentração do analito na amostra. Valores previstos da 

reprodutibilidade (Horwitz values) podem ser calculados pela equação de Horwitz 

(54), que estabelece para qualquer método e qualquer matriz ou analito 

(PASCHOAL et al., 2008): 

 

RSDR= 2(1-0,5logC)                                                  (54) 

 

onde: 

C – valor da concentração do analito. 

 

 Desse modo, substituindo-se os níveis de concentração nessa 

equação, obtêm-se os valores de RSDR apresentados na TAB 4.9.  

 

 TABELA 4.9 – Valores de Horwitz para diferentes faixas de concentração (WOOD, 1999)  

Faixa de concentração  RSDR 

1 (100%) 2 

10-1 2,8 

10-2  (1%) 4 

10-3 5,6 

10-4 8 

10-5 11 

10-6  (ppm) 16 
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10-7 23 

10-8 32 

10-9  (ppb) 45 

 

 Ainda que esses valores representem um valor médio de RSDR 

(Horwitz chegou a esses valores considerando cerca de 3000 ensaios 

interlaboratoriais) e que sejam uma aproximação da precisão possível de ser 

atingida, considera-se como aceitáveis os desvios que sejam menores que o 

dobro do valor teórico de RSDR para a concentração de interesse. Utiliza-se do 

chamado valor de HORRAT, para se ter uma medida da aceitabilidade da 

precisão de um método.  

 O valor de HORRAT é dado por (55): 

  

HoR = RSDR do método / (RSDR teórico )                             (55) 

 

Assim, se HoR for menor ou igual a 2, o método pode ser considerado 

como satisfatoriamente reprodutível (WOOD, 1999). 

No caso do teste U-score (BROOKES et al., 1979; SHAKHASHIRO et 

al., 2006), a avaliação inclui as incertezas experimentais e dos valores 

recomendados em um nível de confiança de 95% (±2s). Este teste foi 

estabelecido como mais apropriado para as análises dos dados dos elementos 

que possuíam valores certificados, pois esse teste contempla os valores obtidos 

experimentalmente e os valores certificados, bem como as incertezas a eles 

associadas.   

 Nos materiais de referência analisados, a incerteza informada pelo 

certificado é de ±2s, enquanto o valor da incerteza obtida através do programa k0-

IAEA é de ±1s. O U-score é dado pela expressão (56). 

    

` � |PaRS: PTUVW|
bcaRS� - cTUVW�

            (56) 
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onde: 

xlab – valor obtido com a média aritmética das replicatas; 

xcert – valor informado no material certificado; 

ULab – valor da incerteza expandida das replicatas, obtida através da multiplicação 

da incerteza obtida no laboratório por 2; 

Ucert – valor da incerteza expandida do material certificado. 

 

O teste U-score estabelece que: 

 

U < 2,58 nível de confiança de 99,5%; 

U < 1,96 nível de confiança de 95% 
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5. RESULTADOS E DISCUSSÃO 

 

5.1  Valores de f e α para as posições de irradiação utilizadas 

 

 Os parâmetros de fluxo obtidos para a estação pneumática do IPEN 

foram determinados pelo programa k0-IAEA (TAB. 5.1) e também pelo programa 

KayWin (TAB. 5.2), trazido pelo Dr. Radojko Jacimovic, do Instituto Jozef Stefan - 

Eslovênia, em visita realizada ao LAN-IPEN no período de 13 a 31 de agosto de 

2012. Como podemos verificar, os valores obtidos não apresentaram diferenças 

significativas. Para a razão entre o fluxo térmico e epitérmico (parâmetro f), a 

contribuição do espectro de nêutrons epitérmicos é significativa. Os valores 

obtidos para o parâmetro alfa são positivos, indicando um espectro de nêutrons 

epitérmicos "suave". Valores positivos para o parâmetro alfa também indicam uma 

boa termalização (DE CORTE, 1987b). Para a posição de irradiação 24B, os 

valores obtidos (TAB. 5.3) indicam que a contribuição epitérmica é menos 

significativa.  As FIG. 5.1 e 5.2 mostram como esses valores foram inseridos no 

programa k0-IAEA. 

 
 

TABELA 5.1 - Dados da caracterização da estação pneumática. Reator a potência crítica de 
4,5MW. Valores obtidos com o programa k0-IAEA. 

Parâmetros Valores 

Fluxo de nêutrons térmicos, φth (m
-2 s-1) (1,82 ± 0,05) ⋅ 1016 

Fluxo de nêutrons rápidos, φfast (m
-2 s-1) (3,66 ± 0,37) ⋅ 1015 

Temperatura neutrônica, Tn, (K) 310 ± 5 

Razão fluxo térmico epitérmico, f 35,6 ± 1,1 

Desvio da distribuição do fluxo de nêutrons epitérmicos da lei ideal 1/E, α 0,0288 ± 0,0058 
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TABELA 5.2 - Dados nucleares da estação pneumática. Reator a potência crítica de 4,5MW. 
Valores obtidos com o programa Kayzero for Windows 

Parâmetros Valores 

Fluxo de nêutrons térmicos, φth (m
-2 s-1) (1,88 ± 0,09) ⋅ 1016 

Fluxo de nêutrons rápidos, φfast (m
-2 s-1) (3,66 ± 0,37) ⋅ 1015 

Temperatura neutrônica, Tn, (K) 310 ± 5 

Razão fluxo térmico epitérmico, f 39,46 ± 1,97 

Desvio da distribuição do fluxo de nêutrons epitérmicos da lei ideal 1/E, α 0,0158 ± 0,0063 

 

TABELA 5.3 - Dados nucleares da posição de irradiação 24B prateleira 2.  Reator a potência 
crítica de 4,5MW. Valores obtidos com o programa k0-IAEA 

Parâmetros Valores 

Fluxo de nêutrons térmicos, φth (m
-2 s-1) (8,51 ± 0,09) ⋅ 1016 

Fluxo de nêutrons rápidos, φfast (m
-2 s-1) (4,00 ± 0,20) ⋅ 1015 

Temperatura neutrônica, Tn, (K) 310 ± 5 

Razão fluxo térmico epitérmico, f 62,75 ± 6,03 

Desvio da distribuição do fluxo de nêutrons epitérmicos da lei ideal 1/E, α 0,034 ± 0,010 

 
 
 

 
FIGURA 5.1 – Imagem do programa k0-IAEA com os dados da caracterização da estação 

pneumática. Reator a potência crítica de 4,5MW. 
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FIGURA 5.2 – Imagem do programa k0-IAEA com os dados da caracterização da prateleira 24B 

posição 2. Reator a potência crítica de 4,5MW. 
 

  

5.2  Avaliação estatística dos resultados 

 

 As TAB. 5.4, 5.5 e 5.6 mostram os valores obtidos experimentalmente 

(média aritmética das replicatas), assim como os critérios estatísticos utilizados, 

erro relativo (bias, %), coeficiente de variação (CV) e o teste U-score, tanto nas 

irradiações curtas como nas irradiações longas, para cada material biológico 

certificado.  

A incerteza das medidas experimentais utilizadas no cálculo foram as 

fornecidas pelo programa k0-IAEA, que são calculadas considerando-se fontes de 

incerteza tais como área do pico, constante k0, fluxo de nêutrons, f e α, sendo, 

portanto, a incerteza combinada. As incertezas dos materiais de referência foram 

as descritas nos relatórios fornecidos pelos organismos distribuidores, e são 

dadas em um limite de confiança de 95%.  

Analisando-se os resultados em termos de porcentagem de erro em 

relação aos valores certificados (erros relativos), vê-se que os erros ficaram entre 
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0 e 30%, exceto para o Na (88%) no Peach Leaves; Nd (37%) e Ta (58%) no 

Mixed Polish Herbs.  É importante notar que os erros ficaram, em geral, 

aleatoriamente acima e abaixo dos valores recomendados, indicando que não há 

erros sistemáticos. Foram calculados, também, para efeito de comparação, os 

desvios (bias, %) em relação aos valores certificados ou informativos. Deve-se 

levar em conta, entretanto, que esses valores foram tomados apenas como 

referência, pois não são valores certificados. Com algumas exceções, os 

resultados foram concordantes com os valores informativos. As maiores 

discrepâncias encontradas foram Cr e Sc no Peach Leaves (TAB. 5.4) e Th no 

Tomato Leaves (TAB. 5.6). É importante observar, por outro lado, que esses 

mesmos elementos químicos, que apresentaram desvios significativos em relação 

aos valores informativos, mostraram boa concordância com os valores 

certificados no Mixed Polish Herbs (TAB. 5.5), com U-score inferiores a 1,96, 

mostrando que estão dentro de um nível de confiança de 95%.  

Se analisarmos os dados pelo critério do Coeficiente de Variação (CV), 

vemos que a maior parte dos resultados apresentou desvios entre as replicatas 

inferiores a 20%. Como a concentração da maior parte dos elementos analisados 

se encontra na faixa de mg kg-1 e ng kg-1, vemos que, de acordo com a TAB. 4.9, 

os desvios estão dentro da faixa aceitável para essa faixa de concentração. 

Alguns elementos como o Sb e o Zn, no material de referência Peach Leaves, 

apresentaram desvios maiores que os recomendados na TAB. 5.4. Entretanto, 

esses valores ainda estão dentro dos aceitos conforme com o critério descrito por 

WOOD, 1999 (duas vezes o valor de HORRAT). No material Mixed Polish Herbs, 

os desvios encontrados para os elementos Nd (41%), Sb (40%), U (31%) e V 

(38%), ainda estão abaixo de 45%, índice considerado aceitável para elementos 

na faixa de concentração de ng kg-1. Se considerarmos o valor de Horrat para 

reprodutibilidade, (WOOD, 1999), vemos que todos os valores obtidos, exceto o 

Ta (133%) no Mixed Polish Herbs, foram menores que 2. Isso mostra que houve 

excelente reprodutibilidade nos resultados obtidos experimentalmente.  

Os valores de U-score mostraram que a grande maioria dos resultados 

dos elementos analisados está num intervalo de confiança de 95% (se for 

considerado 1,96 o limite para o U-teste para um nível de confiança de 95%).  As 

únicas exceções foram os valores obtidos para Na (2,55) no Peach Leaves e Na 
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(2,28) no Tomato Leaves. Mesmo assim, os resultados estão dentro de um 

intervalo de confiança de 99,5% (se for considerado 2,58 o valor limite para o U-

teste para um nível de confiança de 99,5%). Isso significa que os resultados não 

diferem significativamente do valor esperado. No caso do Na, foram sempre 

obtidos valores mais altos que os esperados. Isso pode ser devido à contribuição 

da impureza de Na no invólucro de plástico; às reações interferentes no espectro 

de raios gama para a determinação de Na por ativação neutrônica: 23Na(n,γ)24Na; 
24Mg(n,p)24Na e 27Al(n,α)24Na. Pode ser que o programa k0-IAEA não esteja 

resolvendo satisfatoriamente essas interferências físicas nessas matrizes. 
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TABELA 5.4 - Valores médios de concentração obtidos para 6 determinações (N=6), para o material de 
referência SRM 1547 Peach Leaves.  

Elemento 

Valor 
Certificado/Informativo 

(mg/kg) 

Valor 
Experimental 

(mg/kg) 
bias      
(%) 

 
CV      
(%) 

U-
score 

xcert Ucert xLab ULab 

Al[a] 249 3 258 8 4 5 0,81 

Ba[a] 124 4 127 16 2 5 0,18 

Ba[b] 124 4 131 6 6 10 0,97 

Br[a] 11[c] * 11 2 0 4 ** 

Ca (%)[b] 1,56 0,02 1,52 0,16 3 12 0,25 

Ce[b] 10[c] * 13 1 30 4 ** 

Cl[a] 360 19 368 22 2 8 0,28 

Cr[b] 1[c] * 1,8 0,2 80 13 ** 

Eu[a] 0,17[c] * 0,18 0,02 6 7 ** 

Eu[b] 0,17[c] * 0,24 0,02 41 7 ** 

Fe[b] 218 14 265 20 22 15 1,93 

K (%)[a] 2,43 0,03 2,45 0,10 1 3 0,19 

La[a] 9[c] * 8,8 0,6 2 11 ** 

Mg (%)[a] 0,432 0,008 0,425 0,018 2 7 0,36 

Mn[a] 98 3 95 2 3 9 0,78 

Na[a] 24 2 45 8 88 11 2,55 

Nd[b] 7[c] * 10 2 43 5 ** 

Rb[b] 19,7 1,2 20,7 4,2 5 5 0,23 

Sb[b] 0,02[c] * 0,02 0,01 0 49 ** 

Sc[b] 0,04[c] * 0,06 0,01 50 9 ** 

Sm[a] 1[c] * 1,1 0,2 10 10 ** 

Sm[b] 1[c] * 1,5 0,1 50 9 ** 

Sr[a] 53 4 59 10 11 17 0,56 

Tb[b] 0,1[c] * 0,11 0,02 10 11 ** 

Th[b] 0,05[c] * 0,06 0,02 20 17 ** 

Yb[b] 0,2[c] * 0,20 0,02 0 6 ** 

Zn[b] 17,9 0,4 23,2 4,6 30 31 1,15 
* Valores não informados 
** Valores não calculados 
[a] – Valores obtidos nas irradiações curtas 
[b] – Valores obtidos nas irradiações longas 
[c] – Valores informativos 
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TABELA 5.5 - Valores médios de concentração obtidos para 6 determinações (N=6), para o material de 
referência INCT-MPH-2 Mixed Polish Herbs  

Elemento 

Valor 
Certificado/Informativo 

(mg/kg) 

Valor 
Experimental 

(mg/kg) 
bias      
(%) 

 
CV 
 (%) 

U-
score 

xcert Ucert xLab ULab 

Al[a] 670 111 854 108 27 3 1,19 

As[b] 0,191 0,023 0,169 0,062 12 15 0,33 

Ba[a] 32,5 2,5 40,9 8,4 26 14 0,96 

Br[a] 7,71 0,61 8,31 1,12 8 6 0,47 

Ca (%)[b] 1,08 0,07 0,99 0,06 8 9 0,98 

Ce[b] 1,12 0,10 1,25 0,16 12 16 0,69 

Cl (%)[a] 0,284 0,020 0,293 0,014 3 4 0,37 

Co[b] 0,210 0,025 0,226 0,048 8 18 0,30 

Cr[b] 1,69 0,13 2,04 0,26 21 6 1,20 

Cs[b] 0,076 0,007 0,067 0,012 12 8 0,65 

Eu[b] 0,016 0,002 0,018 0,002 13 9 0,71 

Fe[b] 460[c] * 605 54 32 7 ** 

Hf[b] 0,236 0,020 0,232 0,014 2 1 0,16 

K (%)[a] 1,91 0,12 1,96 0,16 3 5 0,25 

La[b] 0,571 0,046 0,639 0,032 12 15 1,21 

Mg (%)[a] 0,292 0,018 0,290 0,024 1 5 0,07 

Mn[a] 191 12 197 30 3 4 0,19 

Mo[b] 0,520[c] * 0,567 0,386 9 11 ** 

Na[a] 350[c] * 411 46 17 7 ** 

Nd[b] 0,457 0,091 0,288 0,104 37 41 1,22 

Rb[b] 10,7 0,7 12,3 2,4 15 9 0,64 

Sb[b] 0,066 0,009 0,055 0,020 17 40 0,50 

Sc[b] 0,123 0,009 0,141 0,012 15 3 1,20 

Sm[b] 0,094 0,008 0,091 0,012 3 14 0,21 

Ta[b] 0,019 0,002 0,030 0,016 58 133 0,68 

Tb[b] 0,014 0,001 0,012 0,004 14 18 0,49 

Th[b] 0,154 0,013 0,137 0,022 11 13 0,67 

U[b] 0,049[c] * 0,046 0,026 6 31 ** 

V[a] 0,952 0,163 1,145 0,286 20 38 0,59 
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Yb[b] 0,053 0,007 0,049 0,006 8 8 0,42 

Zn[b] 33,5 2,1 42,2 4,8 26 5 1,66 
* Valores não informados 
** Valores não calculados 
[a] – Valores obtidos nas irradiações curtas 
[b] – Valores obtidos nas irradiações longas 
[c] – Valores informativos 
 

TABELA 5.6 - Valores médios de concentração obtidos para 6 determinações (N=6), para o material de 
referência SRM 1573a Tomato Leaves  

Elemento 

Valor 
Certificado/Informativo 

(mg/kg) 

Valor 
Experimental 

(mg/kg) 
bias      
(%) 

 
CV 
 (%) 

U-
score 

xcert Ucert xLab ULab 

Al[a] 598 12 643 86 8 5 0,52 

Br[a] 1300[c] * 1278 26 2 3 ** 

Br[b] 1300[c] * 1261 387 3 5 ** 

Ca (%)[b] 5,05 0,09 5,05 0,16 0 8 0 

Ce[b] 2[c] * 2,0 0,2 0 0 ** 

Cl[a] 6600[c] * 7130 198 8 4 ** 

Cr[b] 1,99 0,06 2,27 0,31 14 20 0,89 

Fe[b] 368 7 428 34 16 23 1,73 

Hf[b] 0,14[c] * 0,13 0,02 7 9 ** 

K (%)[a] 2,70 0,05 2,78 0,16 3 4 0,48 

K (%)[b] 2,70 0,05 2,95 0,36 9 10 0,69 

La[b] 2,3[c] * 2,4 0,2 4 18 ** 

Mg (%)[a] 1,2[c] * 1,14 0,04 5 6 ** 

Mn[a] 246 8 251 6 2 3 0,50 

Na[a] 136 4 179 28 32 8 1,52 

Na[b] 136 4 178 18 31 5 2,28 

Rb[b] 14,89 0,27 16,50 3,94 11 10 0,41 

Sc[b] 0,1[c] * 0,11 0,01 10 14 ** 

Sm[b] 0,19[c] * 0,16 0,04 16 21 ** 

Th[b] 0,12[c] * 0,06 0,02 50 19 ** 

Zn[b] 30,9 0,7 30,9 4,8 0 0 0 
* Valores não informados 
** Valores não calculados 
[a] – Valores obtidos nas irradiações curtas 
[b] – Valores obtidos nas irradiações longas 
[c] – Valores informativos 
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6. CONCLUSÕES  

 

 O método do k0-INAA, utilizando o programa k0-IAEA, no reator IEA-R1 

mostrou-se muito satisfatório para a análise de elementos químicos que dão 

origem a radioisótopos de meia-vida curta e longa em materiais biológicos, 

principalmente vegetais.  

 Os resultados obtidos mostraram o bom desempenho do método k0-

INAA com o uso do programa k0-IAEA para analisar diferentes matrizes 

biológicas. Os 32 elementos químicos obtidos pelo método k0-INAA com o 

programa k0-IAEA, com faixas de concentração de mg kg-1 a ng kg-1, 

apresentaram resultados confiáveis de acordo com os critérios estatísticos 

utilizados. O elemento Na, em todas as matrizes, apresentou valor sempre acima 

do recomendado, provavelmente devido à interferência espectral de Mg e Al 

nesse materiais. A irradiação de Mg e Al com nêutrons pode também formar 24Na 

por meio de reações nucleares. A presença de sódio no invólucro de plástico 

onde a amostra foi acondicionada pode também ter contribuído para esses 

valores mais elevados. 

 Somente no material de referência INCT-MPH-2 Mixed Polish Herbs, o 

qual possui a maior parte dos elementos com valores certificados, dos 40 

elementos possíveis de serem determinados utilizando a análise por ativação 

neutrônica, foi possível detectar 31 elementos, com resultados satisfatórios. 

Muitos desses elementos determinados são da ordem de ng kg-1 .  

 Para a aplicação do método k0-INAA algumas medidas devem ser 

realizadas no LAN-IPEN como: 

� ajuste do horário nos computadores utilizados para contagem das 

amostras, pois o programa k0-IAEA utiliza o horário fornecido no arquivo 

desse computador. Esse horário deve estar de acordo com o horário das 

irradiações. 

� descrição correta da geometria do detector. 
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� verificação do tempo de irradiação, conforme mencionado no trabalho. 

Esse detalhe é importante principalmente para irradiações com tempo 

menores de 30s.  

� Nas irradiações longas, maior interação entre os pesquisadores e os 

operadores do reator, para obtenção do tempo exato do início e final da 

irradiação. 

 A crítica, neste trabalho, é sobre o programa k0-IAEA. Sua estrutura de 

funcionamento, inserção de dados na base de dados permanente e a análise dos 

espectros, não é amigável de ser realizada para iniciantes.  Seu manual não é de 

simples entendimento, pois faltam detalhes importantes para sua utilização. O 

programa k0-IAEA é fundamentalmente baseado na análise de espectros, assim é 

necessário observar todos os espectros das amostras e se julgar procedente 

eliminar alguns picos, mudar seus ajustes e encontrar os picos não detectados. 

Porém, uma vez ambientado com a estrutura de funcionamento do programa, 

este se torna muito eficiente para a obtenção de resultados confiáveis na análise 

das amostras. Para amenizar esse problema, foi descrito, no corpo desse 

trabalho, um roteiro de como realizar os principais procedimentos para análise de 

uma amostra (Anexo 1). Um CD-ROM contendo um vídeo que demonstra as 

diversas etapas de utilização do programa foi também anexado ao corpo do 

trabalho (Anexo 2).  

 A facilidade do método k0-INAA está também no fato de não necessitar 

irradiar um padrão juntamente com a amostra a ser analisada, reduzindo assim os 

custos do laboratório com a compra desses materiais e também o tempo na 

preparação e análise das amostras. Outra vantagem é a gama de elementos 

possíveis de serem detectados em uma só amostra, uma vez que, no método 

comparativo, muitas vezes é necessário à irradiação de mais de um padrão para 

se determinar todos os elementos de uma amostra. 

 Todas as vantagens na utilização do método k0-INAA foram verificadas 

nesse trabalho. Os resultados indicam que a aplicação do método do k0-INAA no 

LAN-IPEN deverá aumentar o potencial analítico do laboratório, mantendo a 

qualidade dos dados.  
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ANEXO 1 - UTILIZAÇÃO DO PROGRAMA k0-IAEA 

 

Será apresentado a seguir um roteiro de utilização do programa k0-

IAEA. Todas as etapas foram descritas com o maior número de detalhes 

possíveis, com o objetivo de facilitar o uso do programa para os potenciais 

usuários.  

Neste roteiro será mostrado como fazer a calibração em energia e 

construção da curva de eficiência; o cálculo dos parâmetros de fluxo; a análise de 

uma amostra.  

 

A.1  Calibração em energia e construção da curva de eficiência 

 

A primeira etapa a se realizar na utilização do programa k0-IAEA é a 

calibração em energia e a curva de eficiência do detector que será utilizado para 

as medidas de espectrometria gama. No caso, o exemplo se refere ao detector de 

Ge hiperpuro GX2020 da Canberra do LAN-IPEN (Canberra3).  

Na base de dados permanente, deverão ser cadastrados os dados 

referentes às fontes de calibração, o recipiente de contagem e as medidas da 

geometria do detector. Essa etapa se refere à introdução dos dados 

característicos do laboratório. 

 

 



81 

 

 

 
Figura A.1 – Clicar em Edit → Permanent Database. 

 
 
 
 
 
 
 
 
 

 
Figura A.2 – Em Analysts selecionar Add para inserir um novo administrador 
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Figura A.3 – Selecionar o ícone Certificates. Em seguida selecionar radionuclides e a função Add 

para inserir os dados das fontes de Cs e Eu. 
 
 
 
 
 
 
 
 

 
Figura A.4 – Selecionar o ícone Detectors. Em seguida utilizar a função Add para inserir os dados 

referentes ao detector utilizado nas contagens. Para inserir os dados no Material é necessário 
retornar e selecionar o ícone Matrices. Em Matrices utilizar a tecla Add para inserir os dados 

referentes ao detector.  
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Figura A.5 – Vista do ícone Matrices com os dados do detector já cadastrado 

 
 
 
 
 
 
 
 

 
Figura A.6 – No ícone Recipients, cadastrar as medições referentes ao recipiente de contagem. 

Para inserir os dados no Material é necessário retornar e selecionar o ícone Matrices. Em 
Matrices utilize a tecla Add para inserir os dados do material do recipiente de contagem. 
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Figura A.7 – Vista do ícone Matrices com os dados do recipente de contagem cadastrado. 

 
  

 Realizada essa etapa, agora vamos criar uma nova Series com todos 

os dados como data e horário das medições, tempo morto, espessuras, distancia 

da posição de medida até o cristal do detector, entre outros. 

 

 
Figura A.8 – Selecione o ícone File e depois New. 
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Figura A.9 – Ir à pasta k0-IAEA que esta em C: e dar um duplo-click. 

 
 
 
 
 
 
 
 

 
Figura A.10 – Dar o nome desejado ao trabalho e clicar em salvar. 
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Figura A.11 – Copiar os arquivos das medições (espectros das fontes de Eu, Cs e o Background) 

dentro da pasta que foi criada com o nome dado no item anterior. 
 
 
 
 
 
 
 
 
 

 
Figura A.12 – Selecionar o ícone Edit e Series database. 
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Figura A.13 – Selecionar o ícone Samples e clicar em Add.  

 
 
 
 
 
 
 
 

 
Figura A.14 – Selecionar Samples. 
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Figura A.15 – Introduzir a quantidade de espectros a serem analisados e selecionar Source. 

 
 
 
 
 
 
 
 

 
Figura A.16 – Selecionar o Tipo de Matriz e Geometria. 



89 

 

 

 
Figura A.17 – Inserir a medida Dry/wet ratio (de acordo com o manual do programa e o tutorial, 

utilizar 1 no caso das fontes de calibração). 
 
 
 
 
 
 

Figura A.18 – Nomear a fonte. 
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Figura A.19 – Selecionar o certificado para a fonte. Depois clicar em Finish para finalizar o 

processo de cadastramento das fontes. 
 
 
 
 
 
 
 
 

 
Figura A.20 – Selecionar cada item e editar se necessário. 
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Figura A.21 – Selecionar cada item e editar se necessário. A Matrix: Air não está cadastrada, é 
necessário sair do Series database e ir no Permanent database – Matrices e cadastrar. Feito 

isso retorne ao serie database e continue o procedimento. 
 
 
 
 
 

  
Figura A.22 – Vista do ícone Matrices com os dados da matriz do Background cadastrado. 
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Figura A.23 – Selecionar cada item e editar se necessário. 

 
 
 
 
 
 
 
 
 

 
Figura A.24 – Selecionar cada item e editar se necessário. 
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Figura A.25 – Selecionar cada item e editar se necessário. 

 
 
 
 
 
 
 
 

 
Figura A.26 – Clique no ícone Add e depois selecione Packaging. 
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Figura A.27 – Selecione todos os itens desejados (nesse caso todos). 

 
 
 
 
 
 
 
 

 
Figura A.28 – Todos os itens selecionados. 
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Figura A.29 – Selecionar o recipiente desejado.  

 
 
 
 
 
 
 
 

 
Figura A.30 – Cadastrar data e horário da preparação das fontes. 



96 

 

 

 
Figura A.31 – Cadastrar data e horário da validade das fontes (se não existir coloque uma 

estimativa). 
 
 
 
 
 
 
 
 

 
Figura A.32 – Altura da fonte. 
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Figura A.33 – Massa da fonte (normalmente não se sabe o valor da massa da fonte então o autor 

sugere utilizar 1). Depois clicar em Finish para completar o processo. 
 
 
 
 
 
 
 
 

  
Figura A.34 – Selecionar cada item e editar se necessário. 
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Figura A.35 – Selecionar cada item e editar se necessário. 

 
 
 
 
 
 
 
 

  
Figura A.36 – Selecionar cada item e editar se necessário. 
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Figura A.37 – Selecionar cada item e editar se necessário. 

 
 
 
 
 
 
 
 

 
Figura A.38 – Selecionar Measurement e clicar em Add. 
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Figura A.39 – Selecionar Measurement. 

 
 
 
 
 
 
 
 

 
Figura A.40 – Selecionar todos os itens desejados (nesse caso todos). 
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Figura A.41 – Todos os itens selecionados. 

 
 
 
 
 
 
 
 

 
Figura A.42 – Selecionar o detector onde foram feitas as medições das fontes (cadastrado 

inicialmente). 
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Figura A.43 – Não é necessário introduzir manualmente data e horário, pois o programa lê dos 

arquivos. 
 
 
 
 
 
 
 
 

                      
Figura A.44 - Não é necessário introduzir manualmente data e horário, pois o programa lê dos 

arquivos. 
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Figura A.45 – Inserir a distância da posição de contagem até o cristal do detector. 

 
 
 
 
 
 
 
 

 
Figura A.46 – O tempo morto não é necessário introduzir manualmente, pois o programa lê do 

arquivo. Depois clique em Finish para finalizar. 
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Figura A.47 – Selecionar Measurement – Sample 1, clicar em Edit e abrir a caixa de diálogo 

Spectrum filename. 
 
 
 
 
 
 
 
  

 
Figura A.48 – Selecionar os arquivos copiados na pasta referente ao trabalho (Figura A.11). O 

primeiro item da Series é o Background. 
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Figura A.49 – Na Sample 2, repetir o procedimento da figura A.47. Selecione o arquivo da fonte de 

Eu. (primeiro Európio). 
 
 
 
 
 
 
 
 

 
Figura A.50 – Na sample 3, repetir o mesmo procedimento da figura A.47. Selecione o arquivo da 

fonte de Cs 
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Figura A.51 – Na Sample 2, repetir o procedimento da figura A.47. Selecione o arquivo da fonte de 

Eu (o mesmo espectro selecionado anteriormente). (2ºEurópio). Realizado esse procedimento 
clique em Exit e saia do Series database. 

 
 

 Nos passos anteriores foi feito o cadastramento dos dados referentes 

ao detector, fontes e recipientes de contagem utilizados. O próximo passo será 

analisar, calibrar em energia e construir a curva de eficiência do detector.  

 
 

  
Figura A.52 – Clicar em Edit → sElect sample → number: 2, Eu-152 
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Figura A.53 – Clicar em Spectrum analysis → Perform peack search. 

 
 
 
 
 
 
 
 

 
Figura A.54 – Clicar em Spectrum analysis → List of detected peaks. Delete o primeiro pico e 

os picos que apresentam apenas 3 contagens. 
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Figura A.55 – Clicar em Spectrum analysis → Calibration → Fit calibration peaks. 

 
 
 
 
 
 
 
 
 
 

 
Figura A.56 – Clicar em Spectrum analysis → Calibration → Energy calibration → dar duplo-

clique na linha desejada e acertar o canal com sua respective energia. 
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Figura A.57 – Depois de todas as linhas acertadas clicar em Spectrum analysis → Calibration → 

Save current energy calibration. 
 
 
 
 
 
 
 
 
 

  
Figura A.58 – Clicar em Spectrum analysis → Calibration → FWHM calibration. Irá aparecer 

uma pergunta : Is there a pulser peak in the spectrum? Responda que não (No). 
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Figura A.59 – Clicar em Spectrum analysis → Calibration → Write current shape calibration. 

 
 
 

                                                       
Figura A.60 – Selecione number:1, Background. 

 
 

                  
Figura A.61 – Clicar em Spectrum analysis → Perform peak search. 
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Figura A.62 – Clicar em Spectrum analysis → List of detected peaks. Delete o primeiro pico. 

 
 
 
 
 
 
 
 
 

 
Figura A.63 – Clicar em Spectrum analysis → Analyze all peaks. 
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Figura A.64 – Clicar em View → Raw (or fitted) spectra. 

 
 
 
 
 
 
 
 

 
Figura A.65 – Com o botão direito do mouse na tela, depois selecione a opção Fit view. 
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Figura A.66 – Visualize cada pico utilizando as teclas de avanço ou recuo do teclado. Existindo a  

necessidade de excluir, inserir ou modificar a estimativa de picos poderá ser feito aqui.  
 
 
 
 
 
 
 
 
 
 

 
Figura A.67 – Ao visualizar o ultimo pico aparecerá uma mensagem de aviso. Clique em OK. 

Depois clique em Spectrum analysis → Reanalyze All Peaks. 
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Figura A.68 – Clicar em Spectrum analysis → Write peak areas to file.  

 
 
 
 
 
 
 
 
 

 
Figura A.69 – Clicar em Detector → Background spectra → Store background spectrum. 
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Figura A.70 – Clicar em Edit → Options for interpretation → selecionar Correct for dead time. 

 
 

 
Figura A.71 – Selecionar number: 2, EU-152 (First Europio) novamente. 

 
 
 

 
Figura A.72 – Como já foi deletados o primeiro pico e os picos com 3 contagens. Repita o 

procedimento das FIG. A.63 a A.68. 
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Figura A.73 – Selecione number: 3, Cs-137. 

 

 
Figura A.74 – Clicar em Spectrum analysis → Perform peak search. 

 

 
Figura A.75 – Clicar em Spectrum analysis → List of detected peaks. Delete o primeiro pico. 
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Figura A.76 – Clicar em Spectrum analysis → Analyze all peaks. Feito isso, todos os 

procedimentos realizados nas FIG. A.64 a A.68 devem ser refeitos para o Cs-137. 
 
 
 
 
 
 
 
 
 

 
Figura A.77 – Clicar em Edit → Interpret selected sample. 
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Figura A.78 – Clicar em Detector → Efficiency curves → Store efficiency curves. 

 

 
Figura A.79 – Selecionar number:4, EU-152 Second Europio. 

 
 

 
Figura A.80 – Clicar em Spectrum analysis → Perform peak search. 
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Figura A.81 – Clicar em Spectrum analysis → List of detected peaks. Delete o primeiro pico e 

os picos que apresentam apenas 3 contagens. 
 
 
 
 
 
 
 
 

 
Figura A.82 – Clicar em Spectrum analysis → Analyse all peaks. Feito isso, todos os 

procedimentos realizados nas figura A.64 a A.68 devem ser refeitos para o EU-152 (Second 
Europio). 
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Figura A.83 – Clicar em Edit → Interpret selected sample. 

 
 
 
 
 
 
 
 
 

 
Figura A.84 – Em seguida aparecerá esta janela. 
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Figura A.85 – Clicar em OK. 

 
 
 
 
 
 
 
 
 

 
Figura A.86 – Clicar em View → Efficiency curves for the spectra. 
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Figura A.87 – Em seguida aparecerá a curva de eficiência.  

 
 Se a curva de eficiência apresentar problema, ou o valor de qui-

quadrado ficar muito alto, então é necessário fazer uma investigação mais 

detalhada nos espectros. Se ainda persistir o problema, é recomendado fazer 

uma nova medida para as fontes de Eu e Cs. 

 Caso a curva não apresente problema então poderá ser salva 

realizando os procedimentos abaixo.  

 Uma vez salva a curva não poderá ser modificada. Para fazer alguma 

alteração terá que repetir os procedimentos anteriores.  

 

 
Figura A.88 – Clicar em Detector → Efficiency curves → Store efficiency curves. Feito isso, o 

detector cadastrado está pronto para ser utilizado. 

B. Cálculo dos Parâmetros de Fluxo 
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 A próxima etapa a ser realizada após a calibração do detector é o 

cálculo dos parâmetros de fluxo. 

 Esta etapa é a introdução dos dados referente aos monitores de fluxo 

que são utilizados para a caracterização da posição de irradiação e criação da 

base para o cálculo dos parâmetros de fluxo. 

 

 
Figura B.1 – Clicar em Edit → permanent Database 

 

 
Figura B.2 – Selecionar Facilities 
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Figura B.3 – Em Irradiation facility: clique no espaço em branco (logo acima do bp3). Em seguida 

clique no ícone Add. 
 
 
 
 
 
 
 

 
Figura B.4 – Digite o nome desejado e clique em Add novamente. 



125 

 

 

 
Figura B.5 – Clique na seta ao lado do ícone Add. Selecione Irradiation Facility → 

Characterization. 
 
 
 

 
Figura B.6 – Insira os dados. 

 
 O autor do programa sugere que, quando for realizar uma primeira 

caracterização, a data seja anterior à real e os dados acima sejam introduzidos 

como uma primeira aproximação.  
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Figura B.7 – Selecionar Certificates 

 
 
 

 
Figura B.8 – Clique em Add e cadastrar os monitores de fluxo que serão utilizados para a 

caracterização. Qualquer dúvida consulte as TAB. 4.5 e 4.6. 
 

  

 Feito esse cadastro, finalizar e sair do permanent Database. 

 Finalizando a etapa anterior, agora vamos criar uma nova Series com 

todos os dados, como data e horário das medições, tempo morto, espessuras, 

distância da posição de medida até o detector, entre outros.  
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Figura B.9 – Abra o programa k0-IAEA e clique em File → New. 

 
 
 
 
 
 
 
 
 

 
Figura B.10 – Ir à pasta k0-IAEA que está em C: e dar um duplo clique. Em seguida nomear o 

trabalho e clicar em salvar. 
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Figura B.11 – Copiar os arquivos das medições (espectros) dentro da pasta que foi criada com o 

nome dado no item anterior. 
 
 
 
 
 
 
 
 

 
Figura B.12 – Clicar em Edit → Series database. 
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Figura B.13 – Clique em Add → Samples. 

 
 
 
 
 
 
 
 
 
 
 

 
Figura B.14 – Introduzir a quantidade de espectros a serem analisados e selecionar Comparator.  
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Figura B.15 – Selecionar o tipo de Matriz e a Geometria. 

 
 

 
Figura B.16 – Inserir a medida de Dry/wet ratio. 

 
 
 

 
Figura B.17 – Digitar o nome do monitor. 
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Figura B.18 – Selecionar o Certificate do monitor. E clicar em Finish. 

 
 
 
 
 
 
 
 
 

 
Figura B.19 – Imagem da Sample 1 com os dados cadastrados. 
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Figura B.20 – Clicar em Add → Selecione Packaging. 

 
 
 
 
 
 
 
 
 

 
Figura B.21 – Selecione o item desejado. 
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Figura B.22 – Selecionar o recipiente desejado. 

 

 
Figura B.23 – Data e horário de preparação do monitor. O autor sugere que coloque uma data 

anterior da caracterização do fluxo inicial. 
 

 
Figura B.24 – Data e horário da validade do monitor. 
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Figura B.25 – Altura do monitor. Caso não seja possível a medição o autor do programa sugere 

colocar 1mm. 
 
 
 
 
 
 
 
 
 
 
 

 
Figura B.26 – Massa dos monitores de Au + Zr. Clique em Finish. 
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Figura B.27 – Imagem da Sample 1 com os dados de Packaging cadastrados. 

 
 
 
 
 
 
 
 

 
Figura B.28 – Selecionar Measurement → Add. 
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Figura B.29 – Selecionar Measurement. 

 

 
Figura B.30 – Selecionar o item desejado 

 

 
Figura B.31 – Selecionar o detector onde foram feitas as medições das fontes. 
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Figura B.32 – Não é necessário introduzir manualmente data e horário, pois o programa lê 

automaticamente dos arquivos. 
 

 
Figura B.33 – Não é necessário introduzir manualmente data e horário, pois o programa lê 

automaticamente dos arquivos. 
 

  
Figura B.34 – Distância da posição de contagem até o detector. 
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Figura B.35 – Não é necessário introduzir manualmente o tempo morto, pois o programa lê 

automaticamente do arquivo. Clique em Finish para finalizar. 
 
 
 
 
 
 
 
 
 
 
 

 
Figura B.36 – Selecionar Measurement → Sample: 1 → Edit → Spectrum filename selecione o 

espectro a ser analisado. Depois clicar em Edit novamente.  
 
 



139 

 

 

 
Figura B.37 – Como foram realizadas três medidas, o próximo passo será analisá-las.As etapas 

são semelhantes as das figuras B.28 a B.35. Selecione Measurement → Edit. 
 
 
 
 
 
 
 
 
 
 

 
Figura B.38 – Selecionar Measurement. 
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Figura B.39 – Selecione o item desejado. 

 

 
Figura B.40 – Selecionar o detector onde foram feitas as medições das fontes. 

 

 
Figura B.41 – Não é necessário introduzir manualmente data e horário, pois o programa lê 

automaticamente dos arquivos. 
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Figura B.42 – Não é necessário introduzir manualmente data e horário, pois o programa lê 

automaticamente dos arquivos. 
 

 
Figura B.43 – Distância da posição de contagem até o detector. 

 

 
Figura B.44 – Não é necessário introduzir manualmente o tempo morto, pois o programa lê 

automaticamente do arquivo. Depois clique em Finish para finalizar. 
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Figura B.45 – Clicar na seta ao lado de Measurement. Selecione o outro espectro a ser analisado.  

 
 
 
 
 
 
 
 

 
Figura B.46 – Depois de selecionado, clicar em Edit. Selecionar o Spectrum filename a ser 

analisado. Depois clicar em Edit novamente.  
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Figura B.47 – Repetir o procedimento das figuras de B.37 a B.46.  

 
 
 
 
 
 
 
 
 

 
Figura B.47 – Selecionar Activation → Add. 
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Figura B.48 – Selecionar Activation. 

 

 
Figura B.49 – Selecionar o item desejado. 

 

 
Figura B.50 – Selecionar Channel/Position cadastrado anteriormente. 
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Figura B.51 – Colocar data e horário do início da irradiação. 

 
 
 
 
 
 
 
 
 
 
 
 

 
Figura B.52 – Colocar data e horário do final da irradiação. Clicar em Finish. 
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Figura B.53 – Imagem dos dados de ativação cadastrados. Caso exista necessidade de editar, 

clicar no ícone Edit. Feito isso, clicar em Exit para sair do Series database. 
 
 
 
 
 
 
 
 
 
 

 
Figura B.54 – Clicar em Edit → Options for interpretation. 

 



147 

 

 

 
Figura B.55 – Marcar os itens. 

 
 
 
 
 
 
 
 
 

 
Figura B.56 – Como são três espectros para serem analisados. Clicar em View → Select 

spectrum of interest. 
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Figura B.57 – Selecionar o primeiro espectro.  

 

 
Figura B.58 – Clicar em View → Raw (or fitted) spectra. 

 

 
Figura B.59 – Clicar em Spectrum analysis → Perform peak search. 
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Figura B.60 – Clicar em Spectrum analysis → List of detected peaks. Deletar o primeiro pico e 

clicar OK.  
 
 
 
 
 
 
 
 
 

 
Figura B.61 – Clicar em Spectrum analysis → Analyze all peaks.  
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Figura B.62 – No canto inferior da tela clicar com a tecla direita do mouse. Depois selecionar Fit 

view. 
 
 
 
 
 
 
 
 
 

 
Figura B.63 – Visualize cada pico utilizando as teclas de avanço ou recuo do teclado. Existindo a  

necessidade de excluir, inserir ou modificar algum  pico poderá ser feito aqui.  
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Figura B.64 – Ao final aparecera essa mensagem. Clicar em OK para sair. 

 
 
 
 
 
 
 
 
 

 
Figura B.65 – Clicar em Spectrum analysis → Reanalyze all peaks, para salvar todas as 

modificações realizadas nos picos de energias. Depois clicar em Spectrum analysis → Write 
peak areas to file. 
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Figura B.66 – Repetir o procedimento das figuras B.56 a B.65 para os demais espectros 

cadastrados.  
 
 
 
 
 
 
 
 

 
Figura B.67 – Se algum espectro não ficou adequado ou caso queira selecionar algum específico. 

Clicar em Edit → Series database 
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Figura B.68 – Selecionar Measurement. Na seta ao lado de View selecione Spreadsheet. 

 
 
 
 
 
 
 
 
 

 
Figura B.69 – Clicar em Edit e desabilite os espectros se achar necessário. Depois clicar 

novamente em Edit para sair da tela. Clicar no Exit para sair do Series database. 
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Figura B.70 – Clicar em View → History. 

 
 
 
 
 
 
 

 

 
Figura B.71 – Clicar em Edit → Interpret selected sample. Caso tenha habitado mais de um 

espectro, selecionar Interpret All samples. 
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Figura B.72 – Clicar em View → Numerical results. 

 
 
 
 
 
 
 
 
 

 
Figura B.73 – Tela com os resultados obtidos. 
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Figura B.74 – Clicar em Edit → Map fluxes. 

 
 
 
 
 
 
 
 
 

 
Figura B.75 – Clicar em Irradiation facility → Store flux parameters. Ao fazer isso, os valores 

serão gravados no banco de dados.  
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C. Análise de amostras  
 

 Nessa etapa, será mostrado como são feitas as análises das amostras. 

A criação da Series e a introdução dos dados é semelhante ao passo anterior.  

 

 
Figura C.1 – Abra o programa k0-IAEA e clique em File → New. 

 
 
 
 
 

 
Figura C.2 – Ir à pasta k0-IAEA que está em C: dar um duplo-click depois dar o nome desejado e 

clicar em salvar.  
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Figura C.3 – Clicar em Edit → Series database. 

 
 
 
 
 
 
 
 
 

 
Figura C.4 – Selecionar Samples → Add. 
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Figura C.5 – Selecionar Samples. 

 

 
Figura C.6 – Introduzir a quantidade de espectros a serem analisados. 

 

 
Figura C.7 – Selecionar o tipo de Matriz e a Geometria. 
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Figura C.8 – Inserir a medida Dry/wet ratio. 

 
 
 
 
 
 
 
 
 
 
 

 
Figura C.9 – Dar o nome do material e clicar em Finsih. 
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Figura C.10 – Em Samples:001 selecionar cada item e editar se necessário. 

 
 
 
 
 
 
 
 

 
Figura C.11 - Em Samples:002 selecionar cada item e editar se necessário. 
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Figura C.12 – Selecionar Packaging → Add. 

 
 
 
 
 
 
 
 
 
 
 

 
Figura C.13 – Selecionar Packaging. 
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Figura C.14 – Selecionar os itens desejados. 

 
 
 
 
 
 
 
 
 
 
 

 
Figura C.15 – Selecionar o recipiente desejado (cadastrado anteriormente). 
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Figura C.16 – Inserir data e horário da preparação das amostras. 

 

 
Figura C.17 – Inserir data e horário da validade das amostras. 

 

 
Figura C.18 – Inserir a altura da amostra. 
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Figura C.19 – Inserir a massa da amostra e clicar em Finish. 

 
 
 
 
 
 
 
 
 
 
 

 
Figura C.20 – Em Packaging, Sample:001. Selecionar cada item e editar se necessário. 
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Figura C.21 – Em Packaging, Sample:002. Selecionar cada item e editar se necessário. 

 
 
 
 
 
 
 
 
 

 
Figura C.22 – Selecionar Measurement → Add.  
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Figura C.23 – Selecionar Measurement. 

 

 
Figura C.24 – Selecionar todos os itens desejados. 

 

 
Figura C.25 – Selecionar o detector onde foram feitas as medições das fontes. 
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Figura C.26 – Não é necessário introduzir manualmente data e horário, pois o programa lê 

automaticamente dos arquivos. 
 

 
Figura C.27 - Não é necessário introduzir manualmente data e horário, pois o programa lê 

automaticamente dos arquivos. 
 

 
Figura C.28 – Distância da posição de contagem até o detector. 
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Figura C.29 – Não é necessário inserir manualmente o tempo morto, pois o programa lê 

automaticamente do arquivo. Clicar em Finish.  
 
 
 
 
 
 
 
 
 

 
Figura C.30 – Inserir os arquivos copiados na pasta referente ao trabalho.  
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Figura C.31 – Selecionar Measurement → Sample: 001 → Edit → Spectrum filename selecione 

o espectro a ser analisado. Depois clicar em Edit novamente.  
 
 
 
 
 
 
 
 
 

 
Figura C.32 – Selecionar Measurement → Sample: 002 → Edit → Spectrum filename selecione 

o espectro a ser analisado. Depois clicar em Edit novamente.  
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Figura C.33 – Como na Sample:001 foram realizadas quatro séries de contagens, temos que 

repetir o procedimento para as demais. Selecionar Measurement → Add. 
 
 
 
 
 
 
 
 
 
 

 
Figura C.34 – Selecionar Measurement. 
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Figura C.35 – Selecionar somente a Sample 001. 

 

 
Figura C.36 – Selecionar o detector onde foram feita as contagens das fontes. 

 

 
Figura C.37 – Não é necessário introduzir data e horário, pois o programa lê automaticamente do 

arquivo. 
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Figura C.38 – Não é necessário introduzir data e horário, pois o programa lê automaticamente do 

arquivo. 
 

 
Figura C.39 – Inserir a distância da posição de contagem até o cristal do detector. 

 

 
Figura C.40 - Não é necessário inserir manualmente o tempo morto, pois o programa lê 

automaticamente do arquivo. Clicar em Finish.  
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Figura C.41 - Selecionar Measurement → Sample: 001 → Edit → Spectrum filename selecione 
o espectro a ser analisado. Depois clicar em Edit novamente. Pronto feito isso você selecionou o 
segundo espectro, agora repetir o procedimento das FIG. C.33 a C.40 para os demais espectros. 

 
 
 
 
 
 

 
Figura C.42 – Ao término do último espectro, em Measurement: deverão aparecer os quatro 

espectros.   
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Figura C.43 – Selecionar Activation → Add. 

 
 
 
 
 
 
 
 
 
 
 

 
Figura C.44 – Selecionar Activation. 
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Figura C.45 – Selecionar os itens desejados. 

 

 
Figura C.46 – Selecionar a Channel/Position cadastrado anteriormente.  

 

 
Figura C.47 – Inserir data e horário do inicio da irradiação.  
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Figura C.48 – Inserir data e horário do fim da irradiação. Clicar em Finish. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figura C.49 – Selecionar cada amostra e editar se necessário. Clicar em Exit para sair. 
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Figura C.50 – Clicar em Edit → Options for interpretation. 

 
 
 
 
 
 
 
 
 

 
Figura C.51 – Marcar os itens.  
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Figura C.52 – Clicar em View → Select spectrum of interest...   

 

 
Figura C.53 – Selecione o primeiro espectro.  

 

 
Figura C.54 – Clicar em View → Raw (or fitted) spectra. 
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Figura C.55 – Clicar em Spectrum analysis → Perform peak search. 

 
 
 
 
 
 
 
 
 
 

 
Figura C.56 – Clicar em Spectrum analysis → List of detected peaks. Apagar o primeiro pico e 

clicar em OK. 
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Figura C.57 – Clicar em Spectrum analysis → Analyze all peaks. 

 
 
 
 
 
 
 
 
 
 

 
Figura C.58 – No canto inferior esquerdo da tela, clicar com o botão direito do mouse na tela. 

Selecionar Fit view. 
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Figura C.59  - Visualize cada pico utilizando as teclas de avanço ou recuo do teclado. Existindo a  

necessidade de excluir, inserir ou modificar algum  pico poderá ser feito aqui.  
 
 
 
 
 
 
 
 
 
 

 
Figura C.60 – Ao término irá aparecer essa mensagem. Clicar em OK para sair. 
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Figura C.61 – Clicar em Spectrum analysis → Reanalyze all peaks. Depois clicar em Spectrum 

analysis → Write peak areas to file. 
 
 
 
 
 
 
 
 
 

 
Figura C.62 – Repetir o procedimento das FIG. C.55 a B.65 para os demais espectros 

cadastrados.  
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Figura C.63 – Se algum espectro não ficou adequado ou caso queira selecionar algum específico. 

Clicar em Edit → Series database 
 
 
 
 
 
 
 
 
 

 
Figura C.64 - Selecionar Measurement. Na seta ao lado de View selecione Spreadsheet 
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Figura C.65 – Clicar em Edit e desabilite os espectros se achar necessário. Depois clicar 

novamente em Edit para sair da tela. Clicar no Exit para sair do Series database. 
 
 
 
 
 
 
 
 
 

 
Figura C.66 – Clicar em Edit → Select sample → number:2. 
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Figura C.67 – Repetir o procedimento das FIG. C.55 a C.61.  

 
 
 
 
 
 
 
 
 

 
Figura C.68 – Feito o procedimento para o monitor de Au, clicar em Edit → interpret All samples.  
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Figura C.69 – Irá aparecer essa mensagem. 

 
 
 
 
 
 
 
 
 
 

 
Figura C.70 – Clicar em View → Numerical results. Depois clicar em View → History. 
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Figura C.71 – Resultado das concentrações calculadas pelo programa para os espectros 

selecionados. 
 
 
 
 
 
 
 
 

 
Figura C.72 – Para salvar os resultados em na extensão *txt., clicar em File → Report → em 

k0_IAEA selecione report. Depois clicar em abrir. 
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Figura C.73 – Nomear o arquivo desejado e clicar em Salvar. 

 
  
 Caso as informações apresentadas não sejam suficientes, é 

recomendado a leitura do manual e o estudo do tutorial.  
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ANEXO 2 - UTILIZAÇÃO DO PROGRAMA k0-IAEA 

  

 Neste CD-ROM contém arquivos, em formatos de vídeos, mostrando 

como realizar a calibração em energia e a construção da curva de eficiência do 

detector, o cálculo dos parâmetros de fluxo e a análise de uma amostra, utilizando 

o programa k0-IAEA. 

 


